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1.0 INTRODUCTION 

1.1 Purpose 

The intended use of this guideline and its attachments is to provide guidance to operators in 
the preparation of their 3d modelling and associated exports.  This is done by setting 
common standards like string and model naming conventions. 

Whilst applying designs may vary, ensuring these common parameters are followed 
maintains consistency in the electronic data and documentation.  Which in turn allows easier 
data/project handover between operators, maintains standards of exports, and promotes 
efficient quality control procedures. 

Using the naming standards is mandatory, these conventions do allow flexibility to 
accommodate single operator areas or multiple operator areas and is identified in this 
document. 

 

1.2 Objectives 

This guideline is to stipulate a standardised system and set out minimum requirement for all 
data that are submitted in The Public Works Standard’s. 

• The production of design must be definitive. It must be undertaken in such a way as 
to ensure that the design concepts for the project can be clearly understood, specified 
for construction, and satisfactorily built as per the Public Works Standard’s. 

• The information shown in the Models and Exports must be logically collected on 
discrete layers. Illogical and onerous grouping of information on the data must be 
avoided. Drawings Exports must be on A1 size sheets and must be suitable for colour 
printing to A3 paper size without loss of clarity. 

• BIM, ADAC and IFC exports to include the required and or option attribute information 
per the PW requirements 

 

1.3 Design and Presentation Software 

This Public Works guideline is orientated around the 12d Model software, with support to 
exports on other CAD software as the standard for the delivery of all PW projects from 
survey through planning, design, tendering, construction, As Constructed and archival 
activities. 

The primary function of design and presentation software, is to support the design 
development process, including the production of: 

• Project drawings, and 

• The project electronic model. 

• Production of the project electronic model assists in: 

• Checking all aspects of the design in a three-dimensional project electronic model 

• Visualising the proposal in the community engagement process 

• Production of contract drawings, including visualisation 

• Production of cross sections at any scale, frequency or skew 
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• Integration of design variations during construction, and 

• Production of As Constructed drawings from the project electronic model. 

 

1.4 References 

This guideline must be read in conjunction with the following documents: 

• PW Survey Guidelines - Codes  

• PW Survey Guidelines – Asset Capture 

• AS5488 SUI Standard 

 

Other Standards may include: 

• Technical Drawing Standard AS1100. 

• ISO19650  

 

1.5 Design requirements 

This Public Works Guideline is to provide consistency and uniformity in its approach to the 
supply of Design data and exports. 

Of paramount importance is the high quality of the exports for each facet of design for 
construction projects. This can only be undertaken by a systematic approach to and 
standardisation of the preparation of construction exports for each project. 

This manual should contain enough scope for users to commence design to achieve the 
desired result. This reference guide assumes that the person reading this has basic 
knowledge of how to use 12D Model, and CAD. 
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2.0 12D MODEL STARTUP 

2.1 General 12d Model Project Startup 

12d Model projects should be run from a location on a Network or in a CDE (common data 
environment).  They should be saved and closed, and if using a CDE, checked in at the end 
of the workday at a minimum.  This ensures the projects are backed up and allows model 
and tin data to be shared between multiple operators. 

A design type or area is to be run in its own project, that is, one project per working folder.  
This allows defined separation of the data files and allows easy sharing between operators. 

Survey and other external data are also to be setup in separate projects.  This promotes this 
data as read only but still allows seamless updates to be shared between all operators. 

In the projects: 

• Fill in the project details as required 

• Use the Project Description panel to record specific information about the 
project.  This will also ensure smooth handovers between operators if 
required and keeps vital information with the project.  Types of information 
that can be recorded here, are: 

o What standards are used 

o Variations to Standards 

o Variations to standard naming conventions 

o Map grid information 

o Survey updates, from and why, etc. 

 

2.2 Support Files 

The Public Works Standard 12d Model files is the standard Setup and Library files that are 
shipped and installed with the 12d Model software. These files have been developed in 
conjunction with the local government authorities to be a common standard. 

Any changes to these files for your company specific additions or modifications should be 
placed into a specified User and User_Lib folder that will then override the installed files.  
These User and User_Lib folders can be specified either via an env.4d file (environment file) 
or by using a start up env_configs.4d file (Configuration file).  A User and User_Lib folder 
may be kept in a company Library location or in the project for specific project modifications 
and or for easier archiving purposes. 

 

Note:  If using company overriding setup files, these should be checked against the installed 

files for updates, when the 12d Model software is updated also.   

To define a User and or User_lib path in the env.4d or env_configs.4d file they are defined 
with the variables: 

User   -> USER_4d  -> Define by path, Fixed or relative. 

User_lib -> USER_LIB_4d -> Define by path, Fixed or relative. 
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Installed Locations 

Setup files are looked for when 12d Model fires up.  They define many of its features. 

For standard Setup files shipped with 12d Model,  they are located in: 

C:\Program Files\12d\12dmodel\15.00\set_ups 

 

The only exceptions to copying and changing these files are the fonts.4d, linestyl.4d, 
plotters.4d, plotsymb.4d, symbol.4d, survey.4d, textstyl.4d, texture.4d and toolbars.4d 
files.  To add your own to these files you can use a silent include file.  By creating your own 
file with a prefix “user_” to the above files, 12d Model will automatically include them with the 
shipped items. 

e.g. By putting your own line styles in a file called “user_linestyl.4d”, placed in the user 
folder, 12d Model will add them to the shipped line styles. 

 

Library files, unlike Setup files which are only access when a project is opened, can be 
accessed or updated and read again during the use of the 12d Model project.  These 
typically include items like map files or plotting files. 

For standard Library files shipped with 12d Model,  they are located in: 

C:\Program Files\12d\12dmodel\15.00\library 

 

For corrections, suggestions or more information on the standards setup files shipped with 
12d Model, please go to the 12d Model Forum: 

https://forums.12dmodel.com/viewforum.php?f=49&sid=6ebd0e21a4c70389cd09bf18cb748e
b9 

 
 
  

https://forums.12dmodel.com/viewforum.php?f=49&sid=6ebd0e21a4c70389cd09bf18cb748eb9
https://forums.12dmodel.com/viewforum.php?f=49&sid=6ebd0e21a4c70389cd09bf18cb748eb9
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2.3 Folder Structure 

The following is a suggested folder structure for the 12d Model area of a Job, and its 
potential contents. 

 

The following are examples of typical folder layouts. 

 

User and User Library Folders – If project base User and User Library folders are not 
required these will be located in the company Library.  These contain the Setup and Library 
files for 12d Model.  For any setup file not found it will use the shipped file as a default. 

Support Folder – Contains Standards and other general reference material for the 12d 
Model projects.  Examples: 

• Current Design Standards and Typical drawings, e.g. Austroads 

• Deliverable Spreadsheets 

• Calculation spreadsheets 

• Verification spreadsheets 

• Title block spreadsheet/CSV file 

 

Project based User and User Library 

Master Share 
files 

Support files 

Import and export files 

12d Model Project 
location 
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Import and Export Folders – Exports, temporary holding area for 12d Export files 

• 12da 

• IFC 

• Reports 

• PDFs 

Files can then be moved from this area to final processing or reference locations. 

For Import files, provides a standard read in area for the data incoming from external 
parties for the 12d Model Projects.  Can be used for Chains, etc. 

Master Share folder – Standard location for writing and reference Master Share files.  

12d Model Projects – Standard location for saving to.  See Project Naming for naming 
convention. 
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2.4 Project Naming 

12d project names are constructed by two mandatory and two optional fields. 

 
1. Job/Project Number 

• Company defined 

• Generally Numeric characters but can contain Alpha characters 

2. Area / Zone or Stage code 

• Up to 4 Numeric or Alpha characters 

• Used to define geographic boundaries. E.g. Zone 01, 02 or 1000, 
2000. Or Area A, B, etc. 

• Codes are passed through to Models and Reference strings. E.g. 
Apply/Strings/RS01A01, tin/Design/1000. 

3. Discipline Code Descriptor 

• Three Alpha characters 

• Identifies type of project 

• Even on small projects data should be managed in individual 
projects, shouldn’t be bundled into one project.  You never know 
when are secondary Designer might be required to assist. 

4. Description 

• Should only be used where required for clarification. E.g. identifying 
design options. 

• Character limit should be enforced. E.g. maximum 15 Characters. 

• For Survey Field pickup and Setout projects, description is the 
Surveyors name/Initials. 

 

  

   12345678 AREA DCD DESCRIPTION 

 
Job/Project Number  

Area/Zone Code 

Discipline Code 
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Discipline Codes List 

CAD = Drafting Project (Can also be used for plotting) 

CIV = Civil Design 

DRN = Drainage Design 

EWD = Earthworks Design 

GIS = GIS Data 

GTD = Geotechnical Data 

MST = Master Project (Used for Sharing everything into) 

RDD = Road Design 

SUR = Survey Data 

SFP = Survey Field Pickup Data 

SET = Survey Setout Data 

TRD = Track design (Rail) 

UTL = Utilities / Services Design 

XDD = External Design Data (Design data received from external companies, etc) 

XTR = External References (CAD Xrefs read in) 

 

Example Project naming 

12345678 01 RDD HIGHWAY  - Design highway project area/zone 1 

12345678 01 RDD LOCAL ROADS - Design local roads project area/zone 1 

12345678 01 CIV    - Small project example, Footpath upgrade 

12345678 01 DRN DRIANAGE  - Stormwater design project area/zone 1 

12345678 01 DRN SEWER  - Sewer design project area/zone 1 

12345678 01 UTL WATER  - Proposed water network project area/zone 1 

12345678 01 UTL LIGHTING  - Proposed lighting project area/zone 1 

12345678 01 XDD LIGHTING  - Lighting project from an external consultant 

12345678 00 MST    - Final project data, shared in from working projects 

12345678 00 GIS    - Project wide GIS information 

12345678 00 SUR FEATURES  - Final project wide survey data. 

12345678 00 SUR LIDAR  - Project wide lidar data 

12345678 01 SFP JOE BLOGGS - Individual survey fields pickup in area/zone 1 

12345678 00 MST FIELD PICKUP - Project wide shared in field pickup data 
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2.5 Standard Views 

The standard for naming views is to name permanent views, and leave temporary views as 
a number.  Warning, temporary views can be deleted at any time.  A permanent view is 
generally organised by the model information turned on inside it. 

 

12d Model starts up with the standard views: 

SURVEY Plan survey data 

DESIGN Plan design data (Usually Apply Models) 

LS  Long Section 

XS  Cross section 

3D  Standard Perspective OpenGL View 

1  Unnamed plan view (Rename it to make it a permanent view) 

 

These views are created on start-up via the setup file setups.4d 

 

The Operator can then create other or remove required views from that point.  These might 
include, but not limited to: 

ALIGNMENTS  Plan view for Reference Strings 

FINAL DESIGN  Plan view for combined, cleaned design strings 

PLOT   Plan view for plot preview prior to exporting 

 

View Control 

12d Model Views come with a standard View Control.  This enables easy re-sizing for the 
views. 

Each view has it as the most right view button   

 

 

Standard view 
sizing according to 
view space 

Increase or 
decrease view via 
direction per click. 
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3.0 PROJECT DOCUMENTATION 

For Audit trial items such as Information sources, Design requirements, record of 
amendments and milestone events in the project’s history, it is essential that 12d Model 
projects be well documented. 

 

12d Model provides several tools to assist with these.  Depending on the type of information 
to be documented, Project => Details 

 

 

  

 

Project Description 

General information on the project. 
Relevant standards used. 
Documentation of variants of 
standard conventions and general 
notes or information sources relevant 
to the project. 

Project Details 

List information regarding Titles, 
project creation date, Designer’s 
name, etc. 

Project Diary 

Records events such as Design 
changes or project milestones. 

You can also view the Description and 
Details panels here. 

Note: Project Diary maybe replaced by a 
CDE e.g. 12d Synergy, which has built in 
revision history. 
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3.1 Project Details 

The Project Details is launched automatically when a new project is created. 

The default for this file is located at,  

C:\Program Files\12d\12dmodel\15.00\set_ups\project_details.dtl 

It can be modified to suit Company requirements, However, Although the field names may 
change, certain fields are mandatory: 

• Project Number 

• Job Title 1 

• Designer Name 

• Start Date 

Other fields such as Job Title 2,3 & 4 maybe be required if zones or other descriptions are 
necessary. 

 

This information is essential for creation details, however it can also be referred to in title 
blocks. 

Do Not close the panel without filling out the required information. <Set> to save changes. 
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3.2 Project Description 

The text inside the Project Description Panel is saved in the project.txt file saved in the 
“.project” folder. 

This is important to supplement the Project Details Panel, containing additional information 
on data to the project, design notes, Standards used and any nonstandard changes. 

It is critical to maintain this information as it is important to the audit trail and handover 
between Designers if required. 

 

 

Example notes: 

1. Design or Survey notes 

• Area/Zone notes 

• Standards Used 

• Information on important design changes 

• Survey information – Source, Updates, Grid. 

2. Model Naming 

• Non Standard naming 

3. String Naming 

• Extra or nonstandard inclusions 

• Temporary strings notes 

4. Snippet or Template Notes 

5. MTF or Apply functions Information 

6. Mapping files 

7. Design Options 
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3.3 Project Diary 

The Project Diary is used to log Milestone events or changes to the project. 

Note: Not required is using a Common Data Environment (CDE) like 12d Synergy as these 
items can be recorded as part of the Check In details. 

 

 

Events recorded could include: 

• Milestone Events 

• Import changes, Import for retrieval revision progress or backup data 

• Data received or updated by external parties 

• Handover to another Designer. 
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4.0 STRING NAMING 

The default string naming convention is shipped with 12d Model in the names.4d file.  This 
also includes the default Model naming convention. 

 

Additions to the naming convention must be documented in the Project Description.  
Requests to add them permanently to the shipped standards can be done via 12d Model 
forum: 

https://forums.12dmodel.com/viewforum.php?f=49&sid=6ebd0e21a4c70389cd09bf18cb748e
b9 

 

No exceptions to the standard naming convention are excepted.  Using this standard is 
essential in effective electronic design and allows the use of mapping files to regulate data 
exports, e.g. to CAD. 

 

4.1 Civil Design Sting Naming 

The string naming convention is split into the following categories: 

Design 

• Reference / Alignment Strings 

• Feature Strings 

• Contour Strings 

• CAD Strings 

Survey 

• Feature Strings 

• Contour Strings 

 

  

https://forums.12dmodel.com/viewforum.php?f=49&sid=6ebd0e21a4c70389cd09bf18cb748eb9
https://forums.12dmodel.com/viewforum.php?f=49&sid=6ebd0e21a4c70389cd09bf18cb748eb9
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4.2 Design Strings 

Reference / Alignment Strings 

Reference strings have Mandatory fields and an Optional field. 

Notes: Only Super Alignments to be used. 

 Reference strings are not to be duplicated in a project. 

 

 

5. Type – The prefix to a Reference/Alignment string will depend on selection from the 
names => Alignment group to define the type of alignment line.  Always starts with 
“RS”. 

• RS - Reference/Alignment String, main alignments 

• RSC – Reference String Construction aid 

• RSK - Reference Kerb alignment 

• RSP - Reference Pathway String 

• RST - Reference Traffic Island String 

• RSW - Reference Retaining Wall String 

• RSDRIVE – Reference Drive String 

• RSD - Reference Drainage String 

• RSV - Reference Vehicle path String 

• MS - Modifier String 

• HS - Hinge String 

For any other type use prefix “RS” followed by another third character that represents 
the Reference String.  If this occurs document in the Project Description Panel. 

6. Area ID – For Complex or multiple Area/Zone Projects this Optional field enables 
unique naming.  For single area jobs this is not required.  Will either be a single 
numeric or alpha character to create a unique name. 

7. Geographic ID – This field indicates where the Reference/Alignment string is 
located. 

8. Number – The last two characters of the string name are a unique identifier for 
alignments using the same Geographic ID. 

 

 

    RS1B01 

 
Reference/Alignment 

type 

 

Design Area 
Identifier 

Geographic 
Identifier 

Reference/Alignment 
Number 
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Assigning Styles to Reference / Alignment Strings 

In the Super Alignment properties Reference strings Must be assigned a style which controls 
the automatic chainage labels, start, end and tangent point symbols.  These styles are 
controlled by the 12d Model setup file astyles.4d. 

 

 

`

 

 

 

 

 

Select label style. 
List below 

Enter major and 
minor intervals 

By selecting uses the 
colour in the General 
properties 

Main Design Styles 

Kerb Returns/Traffic Islands Styles 

Rail / Track Styles 

Where no chainage labels are required 

Component Objects Styles 

Working styles – not for export 
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Design Feature Strings 

Design feature string names consist of a minimum of two fields.  However, extra fields can be 
added for descriptive reasons. 

 

• The prefix characters come directly from the naming convention in the names.4d file 
and define the feature type.  See Design Feature List. 

Example “KL” is Lip of Kerb. 

• An option next field can be added for descriptive or unique naming purposes if 
multiple same string types are required.  This is what the “*” denotes in the feature 
list. 

Example KLB1 or EC1 & EC2. Where “B1” define type of kerb if not using 
attributes and “1” & “2” represent multiple edge of carriageways. 

• The last field is for any string created via a Template or Template Snippet.  This is a 
single “L” or “R” that defines whether the string is to the left or right of the Reference 
String. If using Templates defined left hand and right hand Templates should be 
created with the L and R suffix on the strings, not applied in the Apply MTF function. 

Example KLL and KLR, lip of Kerb Left and Lip of Kerb Right. 

 

Example string name created from a Apply function would be KLL but could also be KLB1L. 

KLL is Lip of Kerb Left 

KLB1L is Lip of Kerb, type B1 on the Left side. 

 

For anything different, missing/alternate feature name, second field descriptors, it should be 
documented in the Project Description Panel. 
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Design Feature List 

NAME BASE MODEL NAME FEATURE 

BDYST* Design/Boundary/SURFACE TYPE [BDYST]  Surface Treatment Boundary 

RP RES Cadastral/Proposed/BOUNDARY [RP RES]  Resumption Boundary 

RP EMT Cadastral/Proposed/BOUNDARY [RP EMT] Resumption Easement Boundary 

BRA* Design/BRIDGE [BRA]  Bridge Abutment 

BRC* Design/BRIDGE [BRC]  Bridge Column 

BRD* Design/BRIDGE [BRD]  Bridge Deck 

BRHT* Design/BRIDGE [BRHT] Bridge Headstock Top 

BRHB* Design/BRIDGE [BRHB] Bridge Headstock Bottom 

BRRS* Design/BRIDGE [BRRS]  Bridge Expansion Joint 

BRS* Design/BRIDGE [BRS]  Bridge Soffit 

BEA* Design/BUILDING [BEA]  building Eaves 

BPD* Design/BUILDING [BPD]  Building Pad 

BWL* Design/BUILDING [BWL]  Building Wall 

BSD* Design/BUILDING [BSD]  Building shed - Bus Shelter 

BB* Design/EARTHWORKS [BB]  Bottom of Bank 

BNI* Design/EARTHWORKS [BNI]  Benching Inside 

BNO* Design/EARTHWORKS [BNO]  Benching Outside 

DB* Design/EARTHWORKS [DB]  Open Drain Back 

DF* Design/EARTHWORKS [DF]  Open Drain Front 

DI* Design/EARTHWORKS [DI]  Open Drain Invert 

EBM* Design/EARTHWORKS [EBM]  Edge of Berm 

INT* Design/EARTHWORKS [INT]  Interface 

FCW* Design/Furniture/FENCE [FCW]  Chainwire Fence 

FN* Design/Furniture/FENCE [FN]  Fence 

FWM* Design/Furniture/FENCE [FWM]  Weldmesh Fence 

HR* Design/Furniture/FENCE [HR]  Handrail 

BCB* Design/Furniture/BARRIER [BCB]  Concrete Barrier 

BLD* Design/Furniture/FENCE [BLD]  Bollard 

BNB* Design/Furniture/BARRIER [BNB]  Noise barrier 

BTB* Design/Furniture/BARRIER [BTB]  Thrie Beam barrier 

BT* Design/EARTHWORKS [BT]  Top of Bank 

BWB* Design/Furniture/BARRIER [BWB]  W Beam barrier 

BWR* Design/Furniture/BARRIER [BWR]  Wire Rope Barrier 

HMP* Design/Furniture/ROAD [HMP]  Hazard marker post 

RGS* Design/Furniture/ROAD [RGS]  Sign 

WMP* Design/Furniture/ROAD [WMP]  Width marker post 

WLSTP1* Design/Furniture/ROAD [WLSTP1]  Wheelstop 1.4m 

WLSTP2* Design/Furniture/ROAD [WLSTP2]  Wheelstop 2.0m 

DWY* Design/DRIVEWAYS [DWY]  Driveway Crossing 

PR* Design/RAMPS [PR] Pram Ramp Crossing 

L1* Design/Line Marking/LINES [L1]  Lane Lane 3x9 

CHEV* Design/Line Marking/LINES [CHEV]  Chevron 

LCY* Design/Line Marking/LINES [LCY]  Cycle Line 
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LC* Design/Line Marking/LINES [LC]  Continuity Lines 1x3 

LB* Design/Line Marking/LINES [LB]  Bus Line 

LE* Design/Line Marking/LINES [LE]  Edge Line 

LNP* Design/Line Marking/LINES [LNP]  No Parking Line 1 

LN* Design/Line Marking/LINES [LN]  Continuous Lines 

LGW* Design/Line Marking/LINES [LGW]  Give Way Line 300 Wide 

LHD* Design/Line Marking/LINES [LHD]  Holding Line 200 Wide 

LHM* Design/Line Marking/LINES [LHM]  Hump Marking 

LD* Design/Line Marking/LINES [LD]  Double Barrier Line 

LL* Design/Line Marking/LINES [LL]  Barrier Line Broken Left 

LR* Design/Line Marking/LINES [LR]  Barrier Line Broken Right 

LML* Design/Line Marking/LINES [LML]  Median Line 

LPL Design/Line Marking/LINES [LPL]  Parking Bays LHS 

LPR Design/Line Marking/LINES [LPR]  Parking Bays RHS 

LPS* Design/Line Marking/LINES [LPS]  Pedestrian Crossing Line - Signals 

LSP* Design/Line Marking/LINES [LSP]  Stop Line 300 Wide 

LS* Design/Line Marking/LINES [LS]  Separation - Centre Line 

LT* Design/Line Marking/LINES [LT]  Turning Line 

LZ* Design/Line Marking/LINES [LZ]  Pedestrian Crossing 

LPB* Design/Line Marking/PAVE [LPB]  Bus Lane Surface Treatment 

LPCH* Design/Line Marking/PAVE [LPCH]  Cycle Lane Pattern Surface Treatment 

LPC* Design/Line Marking/PAVE [LPC]  Cycle Lane Surface Treatment 

LPO* Design/Line Marking/PAVE [LPO]  Other Surface Treatment 

LPTS* Design/Line Marking/PAVE [LPTS]  Special Surface Treatment 

ARROWL* Design/Line Marking/SYMBOLS [ARROWL]  Left Arrow 

ARROWR* Design/Line Marking/SYMBOLS [ARROWR]  Right Arrow 

ARROWSRL* Design/Line Marking/SYMBOLS [ARROWSRL]  Straight Right Left Arrow 

ARROWSL* Design/Line Marking/SYMBOLS [ARROWSL]  Straight Left Arrow 

ARROWSR* Design/Line Marking/SYMBOLS [ARROWSR]  Straight Right Arrow 

ARROWUT* Design/Line Marking/SYMBOLS [ARROWUT]   U-Turn Arrow 

ARROW* Design/Line Marking/SYMBOLS [ARROW]  Straight Arrow 

BIKE* Design/Line Marking/SYMBOLS [BIKE]  Bicycle Symbol 

DPB* Design/Line Marking/SYMBOLS [DPB]  Disabled Parking Bay Symbol 

FHMK* Design/Line Marking/SYMBOLS [FHMK]  Fire Hydrant Mark 

FHTMK* Design/Line Marking/SYMBOLS [FHTMK]  Fire Hydrant Triangle Mark 

PED* Design/Line Marking/SYMBOLS [PED]  Pedestrian Symbol 

VLMK* Design/Line Marking/SYMBOLS [VLMK]  Sluice Valve Mark 

VLTMK* Design/Line Marking/SYMBOLS [VLTMK]  Sluice Valve Triangle Mark 

BAB* Design/RAIL [BAB]  Bottom of Ballast 

BAT* Design/RAIL [BAT]  Top of Ballast 

REF* Design/RAIL [REF]  Edge of Formation 

RLR* Design/RAIL [RL]  Light Rail Lines (The Rail) 

RR* Design/RAIL [RT]  Rail Lines (The Rail) 

CG* Design/ROADS [CG]  Change of Grade 

CR* Design/ROADS [CR]  Crown of Road 
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EB* Design/ROADS [EB]  Edge of Bitumen 

EC* Design/ROADS [EC]  Edge of Carriageway - Lane 

EG* Design/ROADS [EG]  Edge of Gravel 

ES* Design/ROADS [ES]  Edge of Shoulder 

ET* Design/ROADS [ET]  Edge of Track - Unsealed 

EV* Design/ROADS [EV]  Edge of Verge 

EX* Design/ROADS [EX]  Edge of Footway 

FB* Design/ROADS [FB]  Back of Footpath 

FP* Design/ROADS [FP]  Front of Footpath 

KBM* Design/ROADS [KBM]  Back of Median Kerb 

KBN* Design/ROADS [KBN]  Back of Nib Kerb 

KB* Design/ROADS [KB]  Back of Kerb 

KFM* Design/ROADS [KFM]  Face of Median Kerb 

KF* Design/ROADS [KF]  Face of Kerb 

KI* Design/ROADS [KI]  Invert of Kerb 

KLM* Design/ROADS [KLM]  Lip of Median Kerb 

KL* Design/ROADS [KL]  Lip of Kerb 

KTM* Design/ROADS [KTM]  Top of Median Kerb 

KT* Design/ROADS [KT]  Top of Kerb 

SC* Design/ROADS [SC]  Sawcut Line 

VCE* Design/ROADS [VCE]  Edge of Vee Channel 

VCI* Design/ROADS [VCI]  Invert of Vee Channel 

SG* Design/SUBGRADE [SG]  Subgrade 

CWB* Design/WALLS [CWB]  Bottom of Concrete Retaining Wall 

CWT* Design/WALLS [CWT]  Top of Concrete Retaining Wall 

GWB* Design/WALLS [GWB]  Bottom of Wall Gabion 

GWT* Design/WALLS [GWT]  Top of Wall Gabion 

TWB* Design/WALLS [TWB]  Bottom of Wall Timber Pole 

TWT* Design/WALLS [TWT]  Top of Wall Timber Pole 

RWB* Design/WALLS [RWB]  Bottom of Retaining Wall 

RWT* Design/WALLS [RWT]  Top of Retaining Wall 

S CN* Sewer/CONCEPT DESIGN [S CN]  Sewer Concept Design 

S DS* Sewer/DESIGN [S DS]  Sewer Design 

S TBA* Sewer/ABANDONED [S TBA]  Sewer plant to be Abandoned 

S MH* Sewer/MAINTENANCE HOLE [S MH]  Sewer Maintenance Hole - Access Chamber 

S REM* Sewer/REMOVED [S REM]  Sewer plant to be Removed 

S PMA* Sewer/PRESSURE MAIN [S PMA]  Sewer Pressure Main Design 

S PMC* Sewer/PRESSURE MAIN CONCEPT [S PMC]  Sewer Pressure Main Concept Design 

S PM* Sewer/PRESSURE MAIN [S PM]  Sewer Pressure Main 

S VP* Sewer/VENT POLE [S VP]  Sewer Vent Pole 

S V* Sewer/PRESSURE VALVE [S V]  Sewer Pressure Valve 

SW MH* Storm/MAINTENANCE HOLE 
[SW MH]  Stormwater Maintenance Hole - Access 
Chamber 

SW PIT* Storm/PIT [SW PIT]  Stormwater Pit 

SW HA* Storm/HEADWALL APRON [SW HA] Stormwater Headwall Apron 

SW HB* Storm/HEADWALL BOTTOM [SW HB] Stormwater Headwall Bottom 
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SW HT* Storm/HEADWALL TOP [SW HT] Stormwater Headwall Top 

SW TRNT* Storm/TRENCH TOP [SW TRNT]  Stormwater Trench Top 

SW TRNB* Storm/TRENCH BOTTOM [SW TRNB]  Stormwater Trench Bot 

SW SD* Storm/SUBSOIL DRAIN [SW SD]  Subsoil - Side Drain 

SW CL* Storm/Catchment/LABELS [SW CL]  Stormwater Catchment Labels 

SW C3* Storm/Catchment/POLYGONS SET 3 [SW C3]  Stormwater Catchment Polygons Set 3 

SW C2* Storm/Catchment/POLYGONS SET 2 [SW C2]  Stormwater Catchment Polygons Set 2 

SW C1* Storm/Catchment/POLYGONS SET 1 [SW C1]  Stormwater Catchment Polygons Set 1 

SW TCP3* Storm/TC/STRINGS PERVIOUS SET 3 [SW TCP3]  TC Strings Pervious Set 3 

SW TCP2* Storm/TC/STRINGS PERVIOUS SET 2 [SW TCP2]  TC Strings Pervious Set 2 

SW TCP* Storm/TC/STRINGS PERVIOUS [SW TCP]  TC Strings Pervious 

SW TCI3* Storm/TC/STRINGS IMPERVIOUS SET 3 [SW TCI3]  TC Strings Impervious Set 3 

SW TCI2* Storm/TC/STRINGS IMPERVIOUS SET 2 [SW TCI2]  TC Strings Impervious Set 2 

SW TCI* Storm/TC/STRINGS IMPERVIOUS [SW TCI]  TC Strings Impervious 

SW BP* Storm/BYPASS FLOW [SW BY]  Stormwater Overland - Bypass Flow Strings 

SW* Storm/PIPE [SW]  Stormwater Strings - Pipe 
2DBC UNIQUE 
NAME 2D/BC [2DBC UNIQUE NAME] 2d Boundary Condition 
2DSA UNIQUE 
NAME 2D/SA [2DSA UNIQUE NAME] 2d SA Boundary 

2DCODE 2D/CODE [2DCA] 2d  Active Cell Area 

2DGE 2D/LOC [2DGE] 2d  Grid Extents Location 

2DIWL 2D/IWL [2DIWL] 2d Initial Water Levels 

2DMAT 2D/MAT [2DMAT] 2d  Material Area 
2DPO UNIQUE 
NAME 2D/PO [2DPO UNIQUE NAME] 2d  Plot Output Location 

2DQNL 2D/QNL [2DQNL] 2d  Quadtree Level 
2DRF UNIQUE 
NAME 2D/SA RF [2DRF UNIQUE NAME] 2d Rainfall 

2DSOIL 2D/SOIL [2DSOIL] 2d Soil Type 

2DVZSH 2D/VZSH [2DVZSH] 2d Variable Z Shape String 

2DGULLY 2D/ZSH GULLY [2DGULLY] 2d Z Shape Gulley String 

2DRIDGE 2D/ZSH RIDGE [2DRIDGE] 2d Z Shape Ridge String 

2DZSH 2D/ZSH [2DSA UNIQUE NAME] 2d Z Shape String 

T CCTV* Utilities/Communications/CC TV [T CCTV]  Closed Circuit TV 

T CN* Utilities/Communications/CONCEPT DESIGN [T CN]  Communications Concept Design 

T DS* Utilities/Communications/DESIGN [T DS]  Communications Design 

T OF* Utilities/Communications/OPTIC FIBRE [T OF]  Optic Fibre Line 

T REM* Utilities/Communications/REMOVED [T REM]  Communications Plant to be Removed 

T TBA* Utilities/Communications/ABANDONED [T TBA]  Communications Plant to be Abandoned 

E CN* Utilities/Electricity/CONCEPT DESIGN [E CN]  Electricity Concept Design 

E DUCT* Utilities/Electricity/POWER DUCT [E DUCT]  Electricity Power Duct 

E DS* Utilities/Electricity/DESIGN [E DS]  Electricity Design 

E LP* Utilities/Electricity/LIGHT POLE [E LP] Light Pole 

E LOC* Utilities/Electricity/UNDERGROUND LINE [E LOC]  Electricity Line - Underground 

E OH* Utilities/Electricity/OVERHEAD LINE [E OH]  Electricity Line - Overhead 

E PIT* Utilities/Electricity/PIT [E PIT]  Electricity Pit 

E PP* Utilities/Electricity/POWER POLE [E PP]  Power Pole 
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E REM* Utilities/Electricity/REMOVED [E REM]  Electricity Plant to be Removed 

E TBA* Utilities/Electricity/ABANDONED [E TBA]  Electricity Plant to be Abandoned 

G CN* Utilities/Gas/CONCEPT DESIGN [G CN]  Gas Concept Design 

G DS* Utilities/Gas/DESIGN [G DS]  Gas Design 

G REM* Utilities/Gas/REMOVED [G REM]  Gas Plant to be Removed 

G TBA* Utilities/Gas/ABANDONED [G TBA]  Gas to be Abandoned 

P CN* Utilities/Petroleum/CONCEPT DESIGN [P CN]  Petroleum Concept Design 

P DS* Utilities/Petroleum/DESIGN [P DS]  Petroleum Design 

P REM* Utilities/Petroleum/REMOVED [P REM]  Petroleum Plant to be Removed 

P TBA* Utilities/Petroleum/ABANDONED [P TBA]  Petroleum to be Abandoned 

R CN* Utilities/Recycled Water/CONCEPT DESIGN [R CN]  Recycled Water Concept Design 

R DS* Utilities/Recycled Water/DESIGN [R DS]  Recycled Water Design 

R REM* Utilities/Recycled Water/REMOVED [R REM]  Recycled Water to be Removed 

R TBA* Utilities/Recycled Water/ABANDONED [R TBA]  Recycled Water to be Abandoned 

TS CN* Utilities/Traffic/CONCEPT DESIGN [TS CN]  Traffic Signals Concept Design 

TS DS* Utilities/Traffic/DESIGN [TS DS]  Traffic Signals Design 

TS REM* Utilities/Traffic/REMOVED [TS REM]  Traffic Signals Plant to be Removed 

TS TBA* Utilities/Traffic/ABANDONED [TS TBA]  Traffic Signals Plant to be Abandoned 

W CN* Utilities/Water/PIPES [W CN]  Water Concept Design 

W CON* Utilities/Water/PIPES [W CON]  Water Lot Connection 

W DS* Utilities/Water/PIPES [W DS]  Water Design 

W FH* Utilities/Water/VALVES [W FH]  Water Fire Hydrant 

W TBA* Utilities/Water/ABANDONED [W TBA]  Water Plant to be Abandoned 

W REM* Utilities/Water/REMOVED [W REM]  Water Plant to be Removed 

W VL* Utilities/Water/VALVES [W VL]  Water Sluice Valve 

 

 

 

 

Contour Strings 

Design contours create in 12d Model via the Tin => Contour => Contour, Smooth and 
Label function. 

 

NAME BASE MODEL NAME FEATURE 

CNT MAJOR* Contours/Proposed/MAJOR [CNT MAJOR] Contour Major 

CNT MINOR* Contours/Proposed/MINOR [CNT MINOR] Contour Minor 

CNT LABEL* Contours/Proposed/MAJOR [CNT LABEL] Contour Labels 

CNTLL Contours/LABEL LINES [CNTLL]  Contour Label Lines 

 

 

 

Base Model names do not apply if created via the Apply MTF Function 
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CAD Strings 

Although not limited to, for features created in 12d Model not normally created from a Apply 
MTF function, e.g. CAD items.  Base models included. 

Any extra strings created to be documented in the Project Description.  

 

NAME 
SHORTCUT NAME BASE MODEL NAME FEATURE 

AREA BDY AREA CAD/Boundary/AREA [AREA] Boundary Area 

B BREAKLINE tin/BREAKLINE [B]  Breakline 

C CONSTRUCT CAD/Construct/LINE [C]  Construction Line 

CN NUMBERS Plot/Setout/NUMBERS [CN]  Setout Numbers 

CT TABLE Plot/Setout/TABLES [CT] Setout Table 

L LINE CAD/LINE [L]  Cad Line 

TY TEMP CAD/Temp/LINE [TY] Temporary Line 

XS XS CH CAD/CROSS SECTION [XS] Cross Section Line 

 DIM CAD/DIMENSION [DIM] Dimensions 

 DIMT CAD/DIMENSION [DIMT] Dimension Text 

 DLO* CAD/LEADERS [DLO]  Leader Open 

 DLS* CAD/LEADERS [DLS]  Leader Solid 

 TX1.8 CAD/TEXT/18 [TX1.8]  Text 1.8mm 

 TX2.5 CAD/TEXT/25 [TX2.5]  Text 2.5mm 

 TX3.5 CAD/TEXT/35 [TX3.5]  Text 3.5mm 

 TX5.0 CAD/TEXT/5 [TX5.0]  Text 5.0mm 

 TX7.0 CAD/TEXT/7 [TX7.0]  Text 7.0mm 

 TX10 CAD/TEXT/10 [TX10]  Text 10mm 

 TXB CAD/TEXT/BACKGROUND [TXB]  Text Background 

DIS DISCLAIMER Plot/DISCLAIMER [DIS]  Disclaimer 

DRA DRAFT Plot/DRAFT [DRA]  Draft 

GRIDS GRIDS Plot/GRIDS [GRIDS] Grid Lines 

NPT NORTH POINT Plot/NORTH POINT [NPT]  North Point 

 SCALE Plot/SCALE [SCALE]  Scale Bar 

 PLOTCUT* Plot/CUTS [PLOT CUT]  Long and Cross section Labels 

 PLOT* Plot/GENERAL [PLOT]  Plot 

TBLK TITLE Plot/Title/BLOCK [TBLK]  Title Block 

BDYC BDY CON Boundary/CONST [BDY CON]  Construction 

BDYR BDY RAS Boundary/RASTER [BDY RAS]  Raster 

BDYGIS BDY GIS Boundary/GIS [BDY GIS]  GIS Boundary Information 

BDYINT BDY INT Boundary/INTEREST [BDY INT]  Boundary of Interest 

BDYREL BDY REL Boundary/AIR RELIABILITY [BDY REL]  Air Photo Unreliable Data Area 

BDYTIN BDY TIN Boundary/TIN [BDY TIN]  Tin Boundary 

BDYDATA BDY DATA Boundary/DATA [BDY DATA]  Data Boundary 

BDYNULL BDY NULL Boundary/NULL [BDY NULL]  Null Boundary 

 BDY* Boundary/BOUNDARY [BDY]  Boundary 

HT HATCH CAD/HATCH [HT]  Hatch 

 INTS CAD/TADPOLES [INTS]  Interface Symbol 
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RAILC Rail CAD/RAIL [RAILC] Rail 

BAC Barrier CAD/ROAD [BAC] Barrier 

BKC Back of kerb CAD/ROAD [BKC] Kerb Back 

CARC Car CAD/ROAD CAR [CARC] Car 

CHLC Channel CAD/WATERWAY [CHLC] Channel 

CLC Centre line CAD/ROAD [CLC] Centre Line 

CONC Concrete CAD/PATH [CONC] Concrete 

DCC Dish channel CAD/WATERWAY [DCC] Dish Channel 

DWC Driveway CAD/DRIVEWAY [DWC] Driveway 

EBC Bush CAD/VEGETATION [EBC] Bush 

ECC Concrete CAD/PATH [ECC] Edge of Concrete 

GBC Garden Bed CAD/VEGETATION [EGB]  Garden Bed 

EGC Garden Edge CAD/VEGETATION [EGC] Garden Edge 

EMC Metal CAD/ROAD [EMC] Edge of Metal 

ESC Seal CAD/ROAD [ESC] Edge of Seal 

ETC Track CAD/PATH [ETC] Edge of Track 

FPC Footpath CAD/PATH [FPC] Edge of Footpath 

GLC Ground level CAD/SPOTHEIGHT [GLC] Ground Level 

KIC Invert of kerb CAD/ROAD [KIC] Kerb Invert 

INVC Invert CAD/MISC [INVC] Invert 

SBC Speed Bump CAD/ROAD [SBC] Speed Bump 

KC Kerb CAD/ROAD [KC] Kerb 

KXC Kerb crossing CAD/ROAD [KXC] Kerb Crossing 

KLC Lip of kerb CAD/ROAD [KLC] Kerb Lip 

KTC Kerb of top CAD/ROAD [KTC] Kerb Top 

NIBC Nib wall CAD/BANK [NIBC] Nib Wall 

PEDXC Crossing CAD/ROAD MARKING [PEDXC] Crossing 

PRC Pram Ramp CAD/PRAM RAMPS [PRC] Pram Ramp Crossing 

RMPC Ramp CAD/ROAD [RMPC] Ramp 

SKIDC Skid CAD/ROAD [SKIDC] Skid 

TIC Traffic island CAD/ROAD [TIC] Traffic Island 

AVC Air valve CAD/UT AIR [AVC] Air Valve 

CULVC Culvert CAD/WATERWAY [CULVC] Culvert 

DPC Down pipe CAD/UT [DPC] Down Pipe 

DRNC Drain CAD/WATERWAY [DRNC] Drain 

FC Fibre CAD/UT FIBRE [FC] Fibre 

GC Existing gas CAD/UT GAS [GC] Gas 

PC Existing power CAD/UT POWER [PC] Power 

SSC Existing sewer CAD/UT SEWER [SSC] Sewer 

SWC Existing stormwater CAD/UT STORMWATER [SWC] Stormwater 

MHC Manhole CAD/UT [MHC] Manhole 

MHSSC Sewer Manhole CAD/UT SEWER [MHSSC] Manhole Sewer 

MHSWC Stormwater Manhole CAD/UT STORMWATER [MHSWC] Manhole Stormwater 

SUMPC Sump CAD/UT [SUMPC] Sump 

TC Existing telecom CAD/UT TELECOM [TC] Telephone 
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WC Existing water CAD/UT WATER [WC] Water 

FHC Fire hydrant CAD/UT [FHC] Fire Hydrant 

GMC Gas meter CAD/UT [GMC] Gas Meter 

GTC Gully trap CAD/UT [GTC] Gully Trap 

GVC Gas valve CAD/UT [GVC] Gas Valve 

HWC Headwall CAD/BANK [HWC] Headwall 

KSC Kerb sump CAD/UT [KSC] Kerb Sump 

KSWC Kerb stormwater outlet CAD/ UT [KSWC] Kerb Stormwater Outlet 

TRC Tree CAD/VEGETATION [TRC]  Tree 

TFC Turf CAD/VEGETATION [TFC]  Turf 

XREF Xref CAD/XREF [XREF]  Xref 

VP Viewport CAD/VIEWPORT [VP] Viewport 

 

 

4.3 Survey Strings 

Design teams will need to know string codes mainly to identify what the feature is.  This will 
also be aided by the model grouping they will be in.  The String list below also includes the 
standard model. 

Some codes for Survey, generally around features like services or Utilities could have 
addition to the code. E.g. Pipe or Culvert size including material type. 

• A Stormwater Pipe would have the Prefix DR LOC 

• Then could be follow by the pipe size DR LOC600 

• Could also have a suffix of material type DR LOC600RCP 

This would allow mapping files to apply a pipe or culvert dimensions to the Super String. 

 

Survey Feature List 

NAME MODEL NAME FEATURE 

SV COV Cadastral/Survey/BOUNDARY [SV COV]  Covenant Boundary 

SV DB Cadastral/DCDB/BOUNDARY [SV DB]  DCDB Boundary 

SV RL Cadastral/Survey/CONNECTION [SV RL]  Reference Line 

SV RPC Cadastral/Survey/CONNECTION [SV RPC]  Registered Plan Connection 

SV RPE Cadastral/Survey/BOUNDARY [SV RPE]  Easement Boundary 

SV RPP Cadastral/Survey/BOUNDARY [SV RPP]  Parcel Boundary 

SV RPR Cadastral/Survey/BOUNDARY [SV RPR]  Road Boundary 

SV RP Cadastral/Survey/BOUNDARY [SV RP]  Cadastral Boundary 

SV RPS Cadastral/Survey/BOUNDARY [SV RPS]  Secondary Interest 

BR AB survey/Bridge/ABUTMENT [BR AB]  Bridge Abutment 

BR DK survey/Bridge/DECK [BR DK]  Bridge Deck 

BR NDF survey/Bridge/NON DEFINED [BR NDF] Non Defined - Strung 

BR PAR survey/Bridge/PARAPET [BR PAR]  Bridge Parapet 

BR PRS survey/Bridge/PIER [BR PRS]  Bridge Pier Strung 

BR PR survey/Bridge/PIER [BR PR]  Bridge Pier 
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BR SOF survey/Bridge/SOFFIT [BR SOF]  Bridge Structure Soffit 

BR STR survey/Bridge/STRUCTURE [BR STR]  Bridge Structure 

BU AF survey/Building/AWNING [BU AF]  Awing Face 

BU AP survey/Building/AWNING [BU AP]  Awning Posts 

BU COLS survey/Building/COLUMN [BU COLS]  Building Column 

BU DK survey/Building/DECK [BU DK]  Building Deck 

BU DR1 survey/Building/DOOR [BU DR1]  Building Door Single 

BU DR2 survey/Building/DOOR [BU DR2]  Building Door Double 

BU DRR survey/Building/DOOR [BU DRS]  Building Roller Door 

BU DRN survey/Building/DOOR [BU DRN]  Building Door Non Standard 

BU DRS survey/Building/DOOR [BU DRS]  Building Door Strung 

BU DR survey/Building/DOOR [BU DR]  Building Door 

BU DRO survey/Building/DOOR [BU DRO]  Building Door Opening 

BU EAV survey/Building/EAVES [BU EAV]  Building Eaves 

BU FLR survey/Building/FLOOR [BU FLR]  Floor Level 

BU GUT survey/Building/GUTTER [BU GUT]  Building Gutter 

BU LN survey/Building/LINE [BU LN]   Building Line 

BU NDFS survey/Building/NON DEFINED [BU NDFS]  Non Defined Strung 

BU NDF survey/Building/NON DEFINED [BU NDF]  Non Defined 

BU RFS survey/Building/ROOF [BU RFS]  Building Roof Strung 

BU RF survey/Building/ROOF [BU RF]  Building Roof Point 

BU RWB survey/Building/RETAINING WALL [BU RWB]  Retaining Wall Base 

BU RWT survey/Building/RETAINING WALL [BU RWT]  Retaining Wall Top 

BU SHD survey/Building/SHED [BU SHD] Building Shed 

BU SILL survey/Building/SILL [BU SILL]  Building Sill 

BU STP survey/Building/STEPS [BU STP]  Steps 

BU TAN survey/Building/TANK [BU TAN]  Tank 

CK FLDS survey/Creek/MARKS [CK FLDS]  Flood Level or Debris Mark Line 

CK FLD survey/Creek/MARKS [CK FLD]  Flood Level or Debris Mark Point 

CK INV survey/Creek/INVERT [CK INV]  Invert - Base 

CK MHG survey/Creek/MARKS [CK MHG]  Maximum Height Guage 

CK NDFS survey/Creek/NDF [CK NDFS] Creek NDF Strung 

CK NDF survey/Creek/NDF [CK NDF] Creek NDF Point 

CK SEC survey/Creek/SECTION [CK SEC]  Creek Cross Section 

CK TOE survey/Creek/BANKS [CK TOE]  Creek Toe of Bank 

CK TOP survey/Creek/BANKS [CK TOP]  Creek Top of Bank 

CK WE survey/Creek/EDGE [CK WE]   Creek - Water Edge 

CS BASE survey/Construct/BASE [CS BAS]  Base Layer 

CS SB survey/Construct/SUBBASE [CS SB]  Sub Base 

CS SG survey/Construct/SUB GRADE [CS SG]  Sub Grade Bottom of Box 

CS LSB survey/Construct/LOW SUB BASE [CS LSB]  Lower Sub Base 

CS FSL survey/Construct/FSL [CS FSL]  Finished Surface Level 

CS UNS survey/Construct/UNSUITABLE [CS UNS]  Unsuitable Strung 

CS UN survey/Construct/UNSUITABLE [CS UN]  Unsuitable 

CS STKS survey/Construct/STAKED [CS STKS]  As Staked Strung 



 

 

PW Guidelines 

12d Standards and Procedures 

Page 10 

CS STK survey/Construct/STAKED [CS STK]  As Staked 

FE BOLS survey/Fence/BOLLARD [FE BOLS]  Bollard Fence Line 

FE BOL survey/Fence/BOLLARD [FE BOL]  Bollard 

FE GAS survey/Fence/GATE [FE GAS]   Gate (Strung) 

FE GR survey/Fence/SAFETY [FE GR]  Safety Fence 

FE HR survey/Fence/HAND RAIL [FE HR]   Hand Rail 

FE LN survey/Fence/FENCE [FE LN]   Fence Line 

FE LO survey/Fence/LOG [FE LO]  Log Fence 

FE NDF survey/Fence/GENERAL [FE NDF]  Fence General Point 

FE P survey/Fence/POST [FE P]    Post 

RD AS survey/Road Furniture/BARRIERS [RD AS] Armour Barrier 

RD CB survey/Road Furniture/BARRIERS [RD CB]  Concrete barrier 

RD DPTH survey/Road Furniture/SIGNS [RD DPTH]  Water Over Road Depth Indicator 

RD GP survey/Road Furniture/SIGNS [RD GP]  Guide Post 

RD GRD survey/Road Furniture/GRID [RD GRD]  Road Grid 

RD GR survey/Road Furniture/BARRIERS [RD GR]   Armco Guard Rail 

RD BWR survey/Road Furniture/BARRIERS [RD BWR]  Wire Rope Barrier 

RD SG survey/Road Furniture/SIGNS [RD SG]  Sign No Attributes 

RD SNGM survey/Road Furniture/SIGNS [RD SNGM]  Sign Multi Post 

RD SNG survey/Road Furniture/SIGNS [RD SNG]  Sign 

RD SNS survey/Road Furniture/SIGNS [RD SNS]  Sign Strung - Multi Posts 

GN BIN survey/General/OBJECTS [GN BIN]  Rubbish Bin 

GN GPS survey/General/POINTS [GN GPS] GPS Point 

GN GS survey/General/SIGN [GN GS]  Sign 

GN NDFS survey/General/POINTS [GN NDFS]  General Non defined (Strung) 

GN NDF survey/General/POINTS [GN NDF]  General Non Defined 

GN MBS survey/General/OBJECTS [GN MBS]  Post Mail Box Strung 

GN MB survey/General/OBJECTS [GN MB]   Post Mail Box 

GN PHOTO survey/General/PHOTO [GN PHOTO]  Photo Representation 

GN POTSL survey/General/POINTS [GN POTSL]  Pothole 

GN STL survey/General/OBJECTS [GN STL] Street Light 

GN VP survey/General/OBJECTS [GN VP]  General Vent Pipe 

GO BH survey/Geotech/BORE HOLE [GO BH]   Bore Hole 

GO CON survey/Geotech/LEACHATE [GO CON]  Leachate Pipe 

GO GW survey/Geotech/GAS WELL [GO GW]   Gas Well 

GO LMH survey/Geotech/LEACHATE [GO LMH]  Leachate Manhole 

GO MP survey/Geotech/MONITORING [GO MP]   Monitoring Point 

GO NDF survey/Geotech/MONITORING [GO NDFS]  Geotech Undefined Point (Strung) 

GO NDF survey/Geotech/MONITORING [GO NDF]  Geotech Undefined Point 

GO PIT survey/Geotech/PIT [GO PIT]  Geotech Pit 

GO WMP survey/Geotech/MONITORING [GO WMP]  Water Monitoring Point 

HY EPS survey/Hydro/ENVIRO [HY EPS]  Environment Protection Strung 

HY EP survey/Hydro/ENVIRO [HY EP]  Environmental Protection 

HY JET survey/Hydro/FEATURES [HY JET]  Jetty 

HY MK survey/Hydro/MARKS [HY MK]  Navigation Markers 
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HY PON survey/Hydro/FEATURES [HY PON]  Pontoon 

HY RAM survey/Hydro/FEATURES [HY RAM]  Ramp 

HY ROC survey/Hydro/FEATURES [HY ROC]  Rock 

HY SL survey/Hydro/FEATURES [HY SL]  Surface 

HY TG survey/Hydro/MARKS [HY TG]  Tide gauge - Flood depth 

HY WL survey/Hydro/MARKS [HY WL]  Water Level 

HY WM survey/Hydro/MARKS [HY WM]  Water Marker 

LM BB survey/Pave Marking/LINES [LM BB]   Double (Barrier both Directions) 

LM BL survey/Pave Marking/LINES [LM BL]   Double Broken (Barrier Left Direction) 

LM BR survey/Pave Marking/LINES [LM BR]   Double Broken (Barrier Right Direction) 

LM BUS survey/Pave Marking/LINES [LM BUS]  Bus Stop Line 

LM CL survey/Pave Marking/LINES [LM CL]   Continuity Line 

LM EL survey/Pave Marking/LINES [LM EL]   Exit Line 

LM HLL survey/Pave Marking/LINES [LM HLL]  Holding Line 300mm 

LM HLS survey/Pave Marking/LINES [LM HLS]  Holding Line 200mm 

LM LL survey/Pave Marking/LINES [LM LL]   Lane Line 

LM NDF survey/Pave Marking/LINES [LM NDF]  Linemarking Non Defined line 

LM PCS survey/Pave Marking/LINES [LM PCS]  Pedestrian Crossing at Signals 

LM PKL survey/Pave Marking/LINES [LM PKL]   Parking Bay Line LHS 

LM PKR survey/Pave Marking/LINES [LM PKL]   Parking Bay Line RHS 

LM SB survey/Pave Marking/LINES [LM SB]   Stop Bar 

LM SLB survey/Pave Marking/LINES [LM LSB]  Single Broken (Separation) 

LM S survey/Pave Marking/LINES [LM S]    Single Unbroken (SOLID) 

LM TL survey/Pave Marking/LINES [LM TL]   Turning Line 

LM ZL survey/Pave Marking/LINES [LM ZL]   Zone Line 

PM AS survey/Pave Marking/SYMBOLS [PM AS]  Pavement Arrows Multiple 

PM A survey/Pave Marking/SYMBOLS [PM A]  Pavement Arrows 

PM BK survey/Pave Marking/SYMBOLS [PM BK]  Bike Symbol 

PM CV survey/Pave Marking/SYMBOLS [PM CV]  Chevron 

PM COL survey/Pave Marking/PAVE [PM COL]  Pavement Colour Outline 

PM DA survey/Pave Marking/SYMBOLS [PM DA]  Disable Parking 

PM HM survey/Pave Marking/MARKS [PM HM]   Hydrant Marker 

PM THM survey/Pave Marking/MARKS [PMTHM]  Hydrant triangle mark 

PM LT survey/Pave Marking/SYMBOLS [PM LT]   Left Turn Arrow 

PM ML survey/Pave Marking/SYMBOLS [PM ML]   Merge Left Arrow 

PM MR survey/Pave Marking/SYMBOLS [PM MR]   Merge Right Arrow 

PM NDF survey/Pave Mark/NON DEFINED [PM NDF]  Pavement Non Defined Point 

PM PED survey/Pave Marking/SYMBOLS [PM PED]  Pedestrian symbol 

PM RT survey/Pave Marking/SYMBOLS [PM RT]   Right Turn Arrow 

PM SRL survey/Pave Marking/SYMBOLS [PM SRL]  Straight Right Left Arrow 

PM SL survey/Pave Marking/SYMBOLS [PM SL]   Straight Left Arrow 

PM SR survey/Pave Marking/SYMBOLS [PM SR]   Straight Right Arrow 

PM S survey/Pave Marking/SYMBOLS [PM S]    Straight Arrow 

PM TAC survey/Pave Marking/MARKS [PM TAC]  Tactile 

PM UT survey/Pave Marking/SYMBOLS [PM UT]   U-Turn Arrow 
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PM TXT survey/Pave Marking/TEXT [PM TXT]  Text on Road 

PM ZC survey/Pave Marking/SYMBOLS [PM ZC]   Zebra Crossing 
SV BASE 
STATION survey/Marks/BASE STATION [SV BASE]  Base Station 

SV BM survey/Marks/BENCH [SV BM]   Bench Marks 

SV BS survey/Marks/BACK SIGHTS [SV BS]   Survey Backsight Points 

SV CHS survey/Marks/CHECKS [SV CHS]  Survey Check (Strung) 

SV CH survey/Marks/CHECKS [SV CH]  Survey Check 

SV CP survey/Marks/CONTROL POINTS [SV CP]   Control Points 

SV CS survey/Marks/CADASTRAL [SV CS]   Cadastral marks 

SV PSM survey/Marks/PERMANENT [SV PSM]  Permanent Marks 

SV RO survey/Marks/REF OBJECTS OBSERVED [SV RO]   Reference Objects Observed 

SV RE survey/Marks/REF OBJECTS EXIST [SV RE]   Reference Objects Existing 

SV TVL survey/Marks/TRAVERSE LINES [SV TVL]   Traverse Lines 

SV IB survey/Marks/IRON [SV IB]  Iron Bar 

SV IR survey/Marks/IRON [SV IR]  Iron Rod 

SV IS survey/Marks/IRON [SV IS]  Iron Spike 

SV IT survey/Marks/IRON [SV IT]  Iron Tube 

SV OIB survey/Marks/ORIGINAL [SV OIB]  Original - Old Iron Bar 

SV OIR survey/Marks/ORIGINAL [SV OIR]  Original - Old Iron Rod 

SV OIS survey/Marks/ORIGINAL [SV OIS]  Original - Old Iron Spike 

SV OIT survey/Marks/ORIGINAL [SV OIT]  Original - Old Iron Tube 

SV OP survey/Marks/ORIGINAL [SV OP]  Original - Old Peg 

SV ORT survey/Marks/ORIGINAL [SV ORT] Original - Old Reference Tree 

SV PEG survey/Marks/PEG [SV PEG]  Peg 

SV RM survey/Marks/ROUND [SV RM]  Round Mark 

SV RT survey/Marks/REF TREE [SV RT]  Reference Tree 

SV TMP survey/Marks/TEMP [SV TMP]  Temp Control Point 

SV TRIG survey/Marks/TRIG [SV TRIG]  Trig 

PK EQ survey/Parks/PLAY EQUIP [PK EQ]   Playground Equipment 

PK FE survey/Parks/FIT EQUIP [PK FE]  Parks - Fitness Equipment 

PK FN survey/Parks/FURNITURE [PK FN]   Parks - Landscape Furniture 

PK F survey/Parks/FEATURE [PK F]    Parks - Landscape Feature 

PK NDF survey/Parks/GENERAL POINT [PK NDF]  Parks General Point 

RW BAB survey/Railway/BALLAST [RW BAB]  Railway Ballast Bottom (Strung) 

RW BAT survey/Railway/BALLAST [RW BAT]  Railway Ballast Top (Strung) 

RW BOM survey/Railway/FEATURES [RW BOM]  Railway Boom Gate - one shot and width 

RW CG survey/Railway/COMMS [RW CG]  Railway Signal Box Comms General 

RW CON survey/Railway/COMMS [RW CON]  Railway Conduit observed 

RW IJT survey/Railway/RAIL [RW IJT]  Railway Line Isolator Joint - one shot 

RW JT survey/Railway/RAIL [RW JT]  Railway Line Joint - one shot 

RW KP survey/Railway/FEATURES [RW KP]  Railway Kilometer Post 

RW LN survey/Railway/RAIL [RW LN]   Railway Line 

RW MAS survey/Railway/FEATURES [RW MAS]  Railway Mast Arm 

RW NDF survey/Railway/FEATURES [RW NDF]  Railway General Point 

RW PITS survey/Railway/COMMS [RW PITS]  Railway Pit (Strung) 
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RW PIT survey/Railway/COMMS [RW PIT]  Railway Pit 

RW R survey/Railway/RAIL [RW R]  Railway Rail 

RW SIG survey/Railway/FEATURES [RW SIG]  Railway Signals 

RW SGN survey/Railway/FEATURES [RW SGN]  Railway Sign for Trains 

RW SL survey/Railway/RAIL [RW SL]  Railway Sleeper 

RW SWL survey/Railway/FEATURES [RW SWL]  Railway Switch Lever 

RW TOS survey/Railway/RAIL [RW TOS]  Railway Toe of Switch or Point of Switch 

RD CG survey/Road/LANE FEATURES [RD CG]   Change of Grade 

RD CI survey/Road/KERBS [RD CI]   Concrete Invert - Spoon Drain 

RD EB survey/Road/LANE FEATURES [RD EB]   Edge of Bitumen 

RD EG survey/Road/LANE FEATURES [RD EG]   Edge of Unsealed Road 

RD ES survey/Road/LANE FEATURES [RD ES]  Edge of shoulder 

RD ET survey/Road/LANE FEATURES [RD ET]   Edge of Track 

RD EV survey/Road/VERGE [RD EV]  Edge of Verge 

RD KB survey/Road/KERBS [RD KB]   Kerb Back 

RD KI survey/Road/KERBS [RD KI]   Kerb Invert - Nominal Face 

RD KL survey/Road/KERBS [RD KL]   Kerb Lip 

RD KO survey/Road/KERBS [RD KO]   Kerb Only - Face 

RD KT survey/Road/KERBS [RD KT]   Kerb Top 

RD LE survey/Road/SPOT LEVEL [RD LE]   Spot Level 

RD NDFS survey/Road/GENERAL POINT [RD NDFS]  Road General Strung 

RD NDF survey/Road/GENERAL POINT [RD NDF]  Road General Point 

RD FP survey/Road/FLUSH POINT [RD FP] Road Flush Point 

RD RC survey/Road/LANE FEATURES [RD RC]  Road Crown 

RD SUBDR survey/Road/ROAD SUB DR [RD SUBDR]  Road Sub Drain 

SP BA survey/Stockpile/BASE [SP BA]  Stockpile Base 

SP CG survey/Stockpile/TOP [SP CG]  Stockpile 

SP LE survey/Stockpile/TOP [SP LE]  Stockpile Spot Level 

SF AP survey/Points/AERIAL [SF AP]  Aerial Photography Point 

SF CE survey/Surface/CONCRETE [SF CE]   Concrete Slab 

SF CG survey/Surface/CHANGE GRADE [SF CG]   Change of Grade 

SF DW survey/Surface/CONCRETE [SF DW]   Driveways 

SF EF survey/Surface/CONCRETE [SF EF]  Edge of Failure 

SF EOR survey/Surface/ROCK [SF EOR]  Edge of Rock - Stone 

SF EOW survey/Surface/WATER [SF EOW]  Edge of Water 

SF FP survey/Surface/FOOTPATHS [SF FP]   Footpaths 

SF HP survey/Points/HYDROGRAPHIC [SF HP]  Hydrographic Point 

SF IOD survey/Surface/DRAINS [SF IOD]  Invert of Drain 

SF LE survey/Surface/SPOT LEVEL [SF LE]   Surface Level - Spot Level 

SF LP survey/Points/LIDAR [SF LP]  LIDAR Point 

SF MP survey/Points/MOBILE SCAN [SF MP]  Mobile Scanning Point 

SF NDF survey/Surface/GENERAL POINT [SF NDF]  General Non Defined Point 

SF RWB survey/Surface/RETAINING WALLS [SF RWB]  Retaining Wall Base 

SF RWT survey/Surface/RETAINING WALLS [SF RWT] Retaining Wall Top 

SF TOE survey/Surface/BANK [SF TOE]  Toe of Bank 
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SF TOP survey/Surface/BANK [SF TOP]  Top of Bank 

TN CB survey/Tunnel/FEATURES [TN CB]  Tunnel Cabinet 

TN COM survey/Tunnel/UTILITIES [TN COM]  Tunnel Comms 

TN CON survey/Tunnel/UTILITIES [TN CON]  Tunnel Conduit OBS 

TN DOR survey/Tunnel/FEATURES [TN DOR]  Tunnel Door 

TN DORS survey/Tunnel/FEATURES [TN DORS]  Tunnel Door(s) 

TN FS survey/Tunnel/UTILITIES [TN FS]  Tunnel Fire Service 

TN FW survey/Tunnel/STRUCTURE [TN FW]  Tunnel Fascia Wall 

TN LIN survey/Tunnel/STRUCTURE [TN LIN]  Tunnel Linning 

TN LOC survey/Tunnel/STRUCTURE [TN LOC]  Tunnel S/L 

TN NDF survey/Tunnel/FEATURES [TN NDF]  Tunnel Non Defined 

TN RF survey/Tunnel/STRUCTURE [TN RF]  Tunnel Roof 

TN VS survey/Tunnel/FEATURES [TN VS]  Tunnel Ventilation System 

VE CAN survey/Vegetation/TREES [VE CAN]  Tree Canopy Strung 

VE CU survey/Vegetation/CULTIVATION [VE CU]  Edge of Cultivation 

VE EV survey/Vegetation/VEGETATION [VE EV]  Edge of Vegetation 

VE GE survey/Vegetation/GARDEN [VE GE]   Garden Edge 

VE ROT survey/Vegetation/TREES [VE ROT]  Tree Roots (Strung) 

VE SHR survey/Vegetation/TREES [VE SHR]  Shrub 

VE SRZ survey/Vegetation/ZONES [VE SRZ]  Tree Structural Root Zone 

VE TPZ survey/Vegetation/ZONES [VE TPZ]  Tree Protection Zone 

VE TRE survey/Vegetation/TREES [VE TRE]  Trees 

VE TRS survey/Vegetation/TREES [VE TRS]  Trees Strung 

SE EDS survey/Sewer/Located/EFFLUENT [SE EDS]  Sewer Effluent Disposal 

SE GT survey/Sewer/Located/PIT [SE GT]  Sewer Pit 

SE ILC survey/Sewer/Levels/INVERT CHAMBER [SE ILC]  Sewer Invert Level of Chamber 

SE IL survey/Sewer/Levels/INVERT [SE IL]   Invert (Single Point) 

SE IO survey/Sewer/Feature/INSPECTION OPENING [SE IO]  Sewer Inspection Opening 

SE LOC survey/Sewer/Located/PIPE [SE LOC]  Sewer Located - Quality TBA 

SE MHC survey/Sewer/Located/CHAMBER [SE MHC]  Sewer Manhole Chamber Extents 

SE MHS survey/Sewer/Located/MANHOLE [SE MHS]  Sewer Manhole (Strung) 

SE MH survey/Sewer/Located/MANHOLE [SE MH]   Sewer Manhole 

SE NDF survey/Sewer/Feature/GENERAL POINT [SE NDF]  Sewer General Point 

SE OR survey/Sewer/Feature/OVERFLOW [SE OR] Sewer Overflow 

SE PH survey/Sewer/Located/POTHOLE [SE PH]  Pothole 

SE PR survey/Sewer/Located/PIPE RECYCLED [SE PR]  Sewer Pipe Recycled 

SE P survey/Sewer/Located/PIPE [SE P] Sewer Pipe 

SE RES survey/Sewer/Located/RECLAIMED EFFLUENT [SE RES]  Sewer Reclaimed Effluent 

SE STR survey/Sewer/Located/STRUCTURE [SE STR]  Sewerage Structure 

SE PITRDN survey/Sewer/Located/PIT ROUND [SE PITRDN]  Sewer Round Pit 

SE PM survey/Sewer/Located/PRESSURE MAIN [SE PM]  Sewer Pressure Main 

SE TANS survey/Sewer/Located/SEPTIC TANK [SE TANS]  Septic Tank (Strung) 

SE TAN survey/Sewer/Located/SEPTIC TANK [SE TAN]  Septic Tank 

SE VP survey/Sewer/Feature/VENT POLE [SE VP]  Sewer Vent Pole 

SE V survey/Sewer/Feature/PRESSURE VALVE [SE V]  Sewer Pressure Valve 
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S EX Sewer/Non Survey/DBYD [S EX]  Sewer plotted from DBYD 

S LOCP Sewer/Non Survey/PLOTTED [S LOCP]  Sewer plotted 

DR APR survey/Drainage/Located/APRON [DR APR]  Structure Inlet - Outlet Apron 

DR BC survey/Drainage/Located/BOX CULVERT [DR BC]  Box Culvert (Strung) 

DR END survey/Drainage/Located/END STRUCTURE [DR END]  Drain End Structure 

DR FI survey/Drainage/Located/FIELD INLET [DR FI]  Drainage Field Inlet 

DR FLDS survey/Drainage/Levels/FLOOD LINE [DR FLDS]  Flood Level or Debris line 

DR FLD survey/Drainage/Levels/FLOOD MARK [DR FLD]  Flood Level or Debris Mark 

DR GT survey/Drainage/Located/GULLY TRAP [DR GT]  Gully Trap - Catch Pit 

DR HW survey/Drainage/Located/HEADWALL [DR HW]  Structure Inlet - Outlet Headwall 

DR ILC survey/Drainage/Levels/INVERT CHAMBER [DR ILC]  Drainage IL Invert Level of Chamber 

DR IL survey/Drainage/Levels/INVERT [DR IL]  Invert (Single Point) 

DR LOC survey/Drainage/Located/PIPE [DR LOC]  Drainage Located Pipe - Quality TBA 

DR MHC survey/Drainage/Located/MANHOLE [DR MHC]  Drainage Manhole Chamber (Strung) 

DR MHS survey/Drainage/Located/MANHOLE [DR MHS]  Drainage Manhole (Strung) 

DR MH survey/Drainage/Located/MANHOLE [DR MH]  Drainage Manhole (Single Point) 

DR MK survey/Drainage/Feature/MARKER [DR MK]  Drainage Marker 

DR NDF survey/Drainage/Feature/GENERAL POINT [DR NDF]  Drainage General Strung 

DR NDF survey/Drainage/Feature/GENERAL POINT [DR NDF]  Drainage General Point 

DR NDF survey/Drainage/Feature/GENERAL POINT [DR NDF]  Drainage General Point 

DR OC survey/Drainage/Located/OPEN CHANNEL [DR OC]  Open Channel 

DR PH survey/Drainage/Located/POTHOLE [DR PH]  Drainage Pothole 

DR P survey/Drainage/Located/PIPE [DR P]  Drainage Pipe (strung) 

DR WW survey/Drainage/Located/WINGWALL [DR WW]  Structure Inlet - Outlet Wingwall 

DR DPO survey/Drainage/Located/OUTLET [DR DPO]  Down Pipe Outlet 

DR DP survey/Drainage/Feature/DOWN PIPE [DR DP]  Down Pipe 

DR SP survey/Drainage/Feature/STONE PITCH [DR SP]  Stone pitching 

DR SSD survey/Drainage/Located/SUBSOIL DRAIN [DR SSD] Sub Soil Drain 

DR EX Storm/Non Survey/DBYD [DR EX]  Drainage plotted from Digital - DBYD 

DR LOCP Storm/Non Survey/PLOTTED [DR LOCP]  Drainage Service Plotted 

CO BOX survey/Utilities/Communications/Located/TELEPHONE BOX [CO BOX]  Telephone Box 

CO CCVT survey/Utilities/Communications/Feature/CC TV [CO CCTV]  Closed Circuit TV 

CO CON 
survey/Utilities/Communications/Located/TELEPHONE 
CONDUIT [CO CON]   Telephone Conduit Observed - Quality TBA 

CO NDF survey/Utilities/Communications/Located/GENERAL POINT [CO NDF]  General Point 

CO OF survey/Utilities/Communications/Located/OPTIC FIBRE [CO OF]  Optic Fibre Line 

CO OH survey/Utilities/Communications/Located/TELEPHONE LINE [CO OH]   Telephone Line Observed 

CO LOC 
survey/Utilities/Communications/Located/TELEPHONE 
SERVICES [CO LOC]  Telephone Located Services - Quality TBA 

CO MHS survey/Utilities/Communications/Located/MANHOLE [CO MHS]  Manhole (Strung) 

CO MH survey/Utilities/Communications/Located/MANHOLE [CO MH]  Manhole 

CO PH survey/Utilities/Communications/Located/COMMS POTHOLE [CO PH]  Comms Pothole 

CO PILS survey/Utilities/Communications/Located/PILLAR [CO PILS]  Pillar - Strung 

CO PIL survey/Utilities/Communications/Located/PILLAR [CO PIL]  Pillar 

CO PITS survey/Utilities/Communications/Located/TELEPHONE PIT [CO PITS]  Telephone Pit (Strung) 

CO PIT survey/Utilities/Communications/Located/TELEPHONE PIT [CO PIT]  Telephone Pit 

CO P survey/Utilities/Communications/Located/POLE [CO P]  Pole 
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CO MHC 
survey/Utilities/Communications/Located/TELEPHONE 
MANHOLE EXTENTS [CO MHC]  Telephone Manhole Chamber Extents 

CO MK 
survey/Utilities/Communications/Located/TELEPHONE 
CABLE MARKER [CO MK]   Telephone Cable Marker 

T EX Utilities/Communications/Non Survey/DBYD [T EX]  Communications Plotted from Digital - DBYD 

T LOCP Utilities/Communications/Non Survey/PLOTTED [T LOCP]  Communications Plotted 

EL CON survey/Utilities/Electricity/Located/CONDUIT [EL CON]  Electrical Conduit Observed - Quality TBA 

EL H survey/Utilities/Electricity/Located/POLE [EL H]    Pole High Voltage 

EL LHS survey/Utilities/Electricity/Located/POLE [EL LHS]  Pole Low V. High V. S.L. 

EL LHT survey/Utilities/Electricity/Located/POLE [EL LHT]  Pole Low V. High V. Transformer 

EL LHTS survey/Utilities/Electricity/Located/POLE [EL LHTS]  Pole Low V. High V. Transformer S.L. 

EL LH survey/Utilities/Electricity/Located/POLE [EL LH]   Pole Low & High Voltage 

EL LL survey/Utilities/Electricity/Located/POLE [EL LL]   Low Voltage Light in Ground 

EL LS survey/Utilities/Electricity/Located/POLE [EL LS]   Pole Low Voltage & Street Light 

EL LOC survey/Utilities/Electricity/Located/SERVICE [EL LOC]  Service Located Electricity 

EL L survey/Utilities/Electricity/Located/POLE [EL L]    Pole Low Voltage 

EL MHS survey/Utilities/Electricity/Located/MANHOLE [EL MHS]  Manhole (Strung) 

EL MK survey/Utilities/Electricity/Feature/MARKER [EL MK]   Electrical Marker 

EL NDF survey/Utilities/Electricity/Feature/NON DEFINED [EL NDFS]  Non Defined Feature (Strung) 

EL NDF survey/Utilities/Electricity/Feature/NON DEFINED [EL NDF]  Non Defined Feature (Point) 

EL OH survey/Utilities/Electricity/Located/OVERHEAD [EL OH]  Located Overhead Electricity 

EL PH survey/Utilities/Electricity/Located/POTHOLE [EL PH]  Electrical Pothole 

EL PILS survey/Utilities/Electricity/Located/PILLAR [EL PILS]  Pillar - Strung 

EL PIL survey/Utilities/Electricity/Located/PILLAR [EL PIL]  Pillar 

EL PITS survey/Utilities/Electricity/Located/PIT [EL PITS]  Electrical Pit (Strung) 

EL PIT survey/Utilities/Electricity/Located/PIT [EL PIT]  Electrical Pit 

EL PP survey/Utilities/Electricity/Located/POLE [EL PP]  Electrical Power Pole 

EL PTR survey/Utilities/Electricity/Located/PAD [EL PTR]  Electrical Pad Transformer 

EL SO survey/Utilities/Electricity/Located/POLE [EL SO]  Electricity Pole - Light Only 

EL STAY survey/Utilities/Electricity/Located/POLE [EL STAY]  Electricity Stay Pole - Wire 

EL TOW survey/Utilities/Electricity/Located/TOWER [EL TOW]  Tower 

E EX Utilities/Electricity/Non Survey/DBYD [E EX]  Electricity Plotted from Digital - DBYD 

E LOCP Utilities/Electricity/Non Survey/PLOTTED [E LOCP]  Electricity Plotted 

GA LOC survey/Utilities/Gas/Located/SERVICE [GA LOC]  Gas Located Service - Quality TBA 

GA MHS survey/Utilities/Gas/Located/MANHOLE [GA MHS]  Gas Manhole (Strung) 

GA MH survey/Utilities/Gas/Located/MANHOLE [GA MH]  Gas Manhole 

GA MK survey/Utilities/Gas/Feature/MARKER [GA MK]   Gas Marker 

GA MT survey/Utilities/Gas/Feature/METER [GA MT]  Gas Meter 

GA NDFS survey/Utilities/Gas/Feature/GENERAL POINT [GA NDFS]  Gas General (Strung) 

GA NDF survey/Utilities/Gas/Feature/GENERAL POINT [GA NDF]  Gas General Point 

GA PH survey/Utilities/Gas/Located/POTHOLE [GA PH]  Gas Pothole 

GA PITS survey/Utilities/Gas/Located/PIT [GA PITS]  Gas Pit Strung 

GA PIT survey/Utilities/Gas/Located/PIT [GA PIT]  Gas Pit 

GA P survey/Utilities/Gas/Located/PIPE [GA P]  Gas Pipe Observed 

GA SN survey/Utilities/Gas/Feature/MARKER SIGN [GA SN]   Gas Marker Sign 

GA SYP survey/Utilities/Gas/Feature/SYPHON [GA SYP] Gas Syphon 

GA TST survey/Utilities/Gas/Feature/TEST [GA TST]  Gas Test 
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GA V survey/Utilities/Gas/Feature/VALVE [GA V]    Gas Valve 

G EX Utilities/Gas/Non Survey/DBYD [G EX] Gas Plotted from Digital - DBYD 

G LOCP Utilities/Gas/Non Survey/PLOTTED [G LOCP]  Gas Plotted 

LF BH survey/Utilities/Landfill/Feature/BORE HOLE [LF BH]  Landfill Bore Hole 

LF GW survey/Utilities/Landfill/Feature/GAS WELL [LF GW]  Landfill Gas Well 

LF GF survey/Utilities/Landfill/Located/GAS FLOW LINE [LF GF]  Landfill Gas Flow Line 

LF GH survey/Utilities/Landfill/Located/GAS HEAD LINE [LF GH]  Landfill Gas Head Line 

LF GM survey/Utilities/Landfill/Feature/GAS MANIFOLD [LF GM]  Landfill Gas Manifold 

LF LIN survey/Utilities/Landfill/Feature/LINER [LF LIN]  Landfill Liner 

LF LMHS survey/Utilities/Landfill/Located/LEACHATE MH [LF LMHS]  Landfill Leachate MH (Strung) 

LF LMH survey/Utilities/Landfill/Located/LEACHATE MH [LF LMH]  Landfill Leachate MH 

LF LP survey/Utilities/Landfill/Located/LEACHATE PIPE [LF LP]  Landfill Leachate Pipe 

LF MPW survey/Utilities/Landfill/Feature/WATER MONITORING PT [LF MPW]  Landfill Water Monitoring Point 

LF MP survey/Utilities/Landfill/Feature/MONITORING PT [LF MP]  Landfill Monitoring Point 

LF WP survey/Utilities/Landfill/Located/GROUND WATER PIPE [LF WP]  Landfill Ground Water Pipe 

PE CON survey/Utilities/Petroleum/Located/CONDUIT [PE CON]  Petroleum Conduit Observed 

PE LOC survey/Utilities/Petroleum/Located/SERVICE [PE LOC]  Petroleum Located Service - Quality TBA 

PE MK survey/Utilities/Petroleum/Feature/MARKER [PE MK]  Petroleum Supply Marker 

PE NDF survey/Utilities/Petroleum/Feature/GENERAL POINT [PE NDF]  Petroleum General Point 

PE PH survey/Utilities/Petroleum/Located/POTHOLE [PE PH]  Pothole 

PE TANS survey/Utilities/Petroleum/Located/TANK [PE TANS]  Petroleum Tank (Strung) 

PE TAN survey/Utilities/Petroleum/Located/TANK [PE TAN]  Petroleum Tank 

PE V survey/Utilities/Petroleum/Feature/VALVE [PE V]    Petroleum Valve 

P EX Utilities/Petroleum/Non Survey/DBYD [P EX]  Petroleum Plotted from Digital - DBYD 

P LOCP Utilities/Petroleum/Non Survey/PLOTTED [P LOCP]  Petroleum Plotted 

RE CON survey/Utilities/Recycled Water/Located/CONDUIT [RE CON]  Conduit Observed 

RE LOC survey/Utilities/Recycled Water/Located/SERVICE [RE LOC]  Recycled Water Located Service - Quality TBA 

RE SMH survey/Utilities/Recycled Water/Located/MANHOLE [RE SMH]  Manhole (strung) 

RE MH survey/Utilities/Recycled Water/Located/MANHOLE [RE MH]   Manhole 

RE MK survey/Utilities/Recycled Water/Located/MARKER [RE MK]  Recycled Water Supply Marker 

RE MT survey/Utilities/Recycled Water/Feature/METER [RE MT]   Recycled Water Meter 

RE NDF survey/Utilities/Recycled Water/Located/POINT [RE NDF]  General Point 

RE PH survey/Utilities/Recycled Water/Located/POTHOLE [RE PH]  Pothole 

RE V survey/Utilities/Recycled Water/Feature/VALVE [RE V]    Valve 

R EX Utilities/Recycled Water/Non Survey/DBYD [R EX]  Recycled Water Plotted from Digital - DBYD 

R LOCP Utilities/Recycled Water/Non Survey/PLOTTED [R LOCP]  Recycled Water Plotted 

TR CB survey/Utilities/Traffic/Feature/CONTROLLER [TR CB]   Traffic Lights Controller 

TR CAM survey/Utilities/Traffic/Feature/CAMERA [TR CAM]  Traffic Camera 

TR CON survey/Utilities/Traffic/Located/CONDUIT [TR CON]  Traffic Conduit 

TR LOC survey/Utilities/Traffic/Located/SERVICE [TR LOC]  Traffic Service Located - Quality TBA 

TR LTSL survey/Utilities/Traffic/Feature/STREET LIGHT [TR LTSL]  Joint Use Traffic Light - Street Light 

TR LT survey/Utilities/Traffic/Feature/TRAFFIC LIGHT [TR LT]  Traffic Lights 

TR PITS survey/Utilities/Traffic/Feature/PIT [TR PITS]  Traffic Pit (Strung) 

TR PIT survey/Utilities/Traffic/Feature/PIT [TR PIT]  Traffic Pit 

TR P survey/Utilities/Traffic/Feature/POST [TR P]  Traffic Post 
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TR PKM survey/Utilities/Traffic/Feature/METER [TR PKM]  Parking Meter 

TR NDF survey/Utilities/Traffic/Located/POINT [TR NDF]  General Point 

TS EX Utilities/Traffic/Non Survey/DBYD [TS EX]  Traffic Signals Plotted from Digital - DBYD 

TS LOCP Utilities/Traffic/Non Survey/PLOTTED [TS LOCP]  Traffic Signals Plotted 

FS FH survey/Utilities/Fire/Feature/MARKER [FS FH]   Fire Hydrant 

FS GEN survey/Utilities/Fire/Feature/GENERAL [FS GEN] Fire Service General Feature Strung 

FS LOC survey/Utilities/Fire/Located/PIPE [FS LOC]  Fire Located Service - Quality TBA 

FS MK survey/Utilities/Fire/Feature/MARKER [FS MK]  Fire Supply Marker 

FS NDF survey/Utilities/Fire/Located/POINT [FS NDF]  General Point 

FS PS survey/Utilities/Fire/Located/PIPE [FS PS] Fire Service Pipe (Strung) 

FS P survey/Utilities/Fire/Located/PIPE [FS P] Fire Service Pipe (Point) 

FS TANK survey/Utilities/Fire/Feature/TANK [FS TANK]  Fire Tank 

FS V survey/Utilities/Fire/Fittings/VALVE [FS V]    Fire Valve 

IR CON survey/Utilities/Water/Irrigation/CONDUIT [IR CON]  Irrigation Conduit located 

IR GA survey/Utilities/Water/Irrigation/GENERAL [IR GA]  Irrigation General 

IR IS survey/Utilities/Water/Irrigation/SPRINKLER [IR IS]  Irrigation Sprinkler 

WS BH survey/Utilities/Water/Feature/BORE [WS BH]  Water Bore 

WS CON survey/Utilities/Water/Feature/CONDUIT [WS CON]  Conduit Observed 

WS DF survey/Utilities/Water/Fittings/DRINKING [WS DF]  Water Drinking Fountain 

WS LOC survey/Utilities/Water/Located/PIPE [WS LOC]  Water Located Service - Quality TBA 

WS MHS survey/Utilities/Water/Feature/MANHOLE [WS MHS]  Manhole (Strung) 

WS MH survey/Utilities/Water/Feature/MANHOLE [WS MH]   Manhole 

WS MK survey/Utilities/Water/Located/MARKER [WS MK]  Water Supply Marker 

WS MT survey/Utilities/Water/Fittings/Meter [WS MT]   Water Meter 

WS NDF survey/Utilities/Water/Located/POINT [WS NDF]  General Point 

WS PH survey/Utilities/Water/Located/POTHOLE [WS PH]  Water Pothole 

WS PITS survey/Utilities/Water/Feature/PIT [WS PITS]  Water Pit (Strung) 

WS PIT survey/Utilities/Water/Feature/PIT [WS PIT]  Water Pit 

WS TANK survey/Utilities/Water/Feature/TANK [WS TANK]  Water Tank 

WS TAP survey/Utilities/Water/Fittings/TAP [WS TAP]  Tap 

WS V survey/Utilities/Water/Fittings/VALVE [WS V]    Valve 

W EX Utilities/Water/Non Survey/DBYD [W EX]  Water Plotted from Digital - DBYD 

W LOCP Utilities/Water/Non Survey/PLOTTED [W LOCP]  Water Plotted 

UN EX Utilities/Non Survey/Unknown/DBYD [UN EX]  Unknown from Digital - DBYD 

UN LOCP Utilities/Non Survey/Unknown/PLOTTED [UN LOCP]  Unknown Plotted 

UN CON survey/Utilities/Unknown/Feature/CONDUIT [UN CON]  Unknown Conduit 

UN LOC survey/Utilities/Unknown/Feature/SERVICE [UN LOC]  Service Located Unknown Pipes - Quality TBA 

UN MHS survey/Utilities/Unknown/Feature/MANHOLE [UN MHS]   Unknown Manhole (Strung) 

UN MH survey/Utilities/Unknown/Feature/MANHOLE [UN MH]   Unknown Manhole 

UN MK survey/Utilities/Unknown/Feature/MARKER [UN MK]  Unknown Marker Post 

UN OH survey/Utilities/Unknown/Feature/OVERHEAD [UN OH] Unknown Overhead 

UN PITS survey/Utilities/Unknown/Feature/PIT [UN PITS]   Unknown Pit (Strung) 

UN PIT survey/Utilities/Unknown/Feature/PIT [UN PIT]   Unknown Pit 

UN POL survey/Utilities/Unknown/Feature/POLE [UN POL]  Unknown Pole 

UN POT survey/Utilities/Unknown/Locate/POTHOLE [UN POT]  Service Pothole 
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UN STR survey/Utilities/Unknown/Building/STRUCTURE [UN STR]  Unknown Structure 

UN V survey/Utilities/Unknown/Fittings/VALVE [UN V]    Unknown Valve 

 

 

Survey Contour List 

Existing contours created in 12d Model via the Tin => Contour => Contour, Smooth and 
Label 

NAME MODEL NAME FEATURE 

SV MAJ Contours/Survey/MAJOR [SV MAJ]  Survey Major Contour 

SV MIN Contours/Survey/MINOR [SV MIN]  Survey Minor Contour 

SV LAB Contours/Survey/MAJOR [SV LAB]  Survey Contour Label 
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5.0 MODEL NAMING 

Whilst the default model naming conventions are part of the names.4d file, there are other 
ways models are created in 12d Model e.g. through functions like the Apply MTF and other 
12d Model tools. 

 

There can also be additions done to the default model naming conventions to help identify 
owners or if various 12d Model design projects are required for large or multiple zoned 
breakups. 

 

Overall, the grouping of the model tree will use a mixed camel case for the branches with the 
end branch will be all upper case. 

 Examples  

• Alignment/ROADS 

• Design/Furniture/BARRIER 

• Survey models don’t start with a capital – survey/Road/KERBS 

• Tin models don’t start with a capital – tin/Design/Roads 

 

5.1 Survey Models 

All survey Models to have the Prefix “survey/” 

• If the Survey is split into Zones/Areas, the reference is to be added as a 
model branch after the Survey/ e.g. survey/01/ 

See survey string names for other default model names.  Differences to be documented in 
the Project Description. 

 

There are some exceptions where there might be like grouping required for proposed 
features like cadastral boundaries. 

 Examples: 

• Cadastral/Survey/BOUNDARY - Cadastral/Proposed/BOUNDARY 

• Cadastral/Survey/LOT NUMBERS - Cadastral/Proposed/LOT NUMBERS 

• Contours/Survey/MAJOR – Contours/Proposed/MAJOR 

• Contours/Survey/MINOR – Contours/Proposed/MINOR 

 

For Survey Contours the models are: 

• Contours/Survey/MAJOR 

• Contours/Survey/MINOR 

If different intervals are required a prefix group could be added: 

• Contours/Survey/100mm/MAJOR 
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Survey Triangulation Models 

All triangulation models start with “tin/”. 

 

For the general survey triangulation created from feature pick up models from the Tin => 
Create => Triangulate Data. 

• tin/Existing/SURVEY 

Other survey features may require different triangulations.  These could be for calculation, 
visual or other feature data. 

• tin/Existing/LIDAR  - Flown laser survey surface 

• tin/Existing/STRIP  - Translated survey surface for topsoil 
stripping 

• tin/Existing/PAVEMENT - to display existing road areas in plan or 
sections 

When different surface tins need to be combined a Super tin will need to be created.  All 
Super tins to be prefixed with “tin/Super/”. 

• tin/Super/Existing/SURVEY COMBINED - Combined survey features 
and lidar data. 

 

Survey models and tin updates should be created via a Chain.  See 10.0 Chains area. 

 

 

 

  

 

Note: Survey tin models don’t need to be shared out.  This automatically happens 
when the tin is shared. 
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5.2 Design Models 

See the names.4d for default proposed and CAD model naming.  The CAD string naming 
also has a list of the default models names.  The names.4d file also sets the default the 
colour, linestyle and or symbol. 

 

 

Again, manual proposed models will generally start with “Design/” and drafting models start 
with “CAD/”, there can be other types of groupings created from other features.   

The default models can also be added to or used as a Prefix, just like the string names. 

 

Alignment Models, prefix with Alignment/ and generally associated with the string type 
prefix: 

• Alignment/CONSTRUCTION 

• Alignment/KERBS 

• Alignment/PATHS 

• Alignment/TRAFFIC 

• Alignment/WALL 

• Alignment/DRIVE 

• Alignment/DRAINAGE 

• Alignment/VPATH 

• Alignment/ROADS 

• Alignment/MODIFIERS 

• Alignment/HINGE 

Note: Area or Zones can be introduced into models to separate for sharing 
purposes. 

• Alignment/Area ID/ROADS 

 

Colour Model name String name Linestyle 
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Other models and models Prefixes: 

Cadastral/Proposed/*  - Proposed Cadastral models Prefix 

Contours/Proposed//MAJOR - Proposed Major contour model 

Contours/Proposed//MINOR - Proposed Minor contour model 

Boundary/*   - Proposed boundary models 

Fence/*    - Models for fencing design strings 

Plot/*    - Plotting models 

Sight/*    - Sight distance checks 

Trimesh/*   - Proposed Trimesh models 

 

Service and Utility Models: 

Sewer/*   - Proposed Sewer models Prefix 

Storm/*    - Proposed Stormwater models Prefix 

Utilities/Communications/* - Proposed communications models Prefix 

Utilities/Electricity/*  - Proposed electrical models Prefix 

Utilities/Gas/*   - Proposed gas models Prefix 

Utilities/Petroleum/*  - Proposed petroleum models Prefix 

Utilities/Recycled Water/* - Proposed recycled water models Prefix 

Utilities/Traffic/*  - Proposed traffic signal models Prefix 

Utilities/Water/*  - Proposed water models Prefix 

 

Note: Although attributes are an effective way to associate service providers to a string, If 
visual separation is desired then extra tree groupings can be added to a model name. 

 e.g. Utilities/Communications/Telstra/* 
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Proposed models are not only created manually but also through design tools like the Apply 
Function and MTF and Pavement Manager.  These various features can have different ways 
to set the Models. 

 

Apply Many Defaults 

The apply function models are controlled by the apply many defaults.4d file.  This file is 
shipped with the 12d Model setups.  These models are all prefixed with “Apply/”. 

The “*” suffix represents the alignment name. 

• Apply/Strings/* 

• Apply/Sections/* 

• Apply/VIS Polygons/*    - The Alignment name can be removed to have a 
combined model for all 

• Apply/Road Boundaries/*- The Alignment name can be removed to have a 
combined model for all 

• Apply/Tadpoles/*    - The Alignment name can be removed to have a 
combined model for all 

 

 

Pavement Manager 

The pavement models are defined in the defaults tab of the Pavement manager. The 
Pavement Manager is found in the Design menu Design => Pavement => Pavement styles 
manager 

 

 

The above are the standard pavement models names.  If your company wishes to modify 
these, they can be changed and write out a new Pavement Style via the Design => 
Pavement => Read/Write Pavement Manager.   
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Your new Pavement Style.12dpmn file can be read in to maintain consistency on all 
projects. 

 

Pavement Layer Names 

12d Model ships with an example Pavement Layer Names file. 

 

It is a simple choice list for pavements, kerbs and verges.  The Pavement Layer Names file is 
a text editable file conforming of three columns: 

Abbreviated Name Description Choice Group List 

 

A Pavement Layer Names file can be created to suit your Companies requirements for each 
Client or all Clients using the Groups to separate.  These files can be kept in in your 
Company User Lib folder for selection. 

 

 

 

 

Select file 
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5.3 Design Tins 

See design tin naming.  “*” represents alignment name. 

9. tin/Apply/*    - Created from the apply function per 
alignment 

10. tin/Design/[DESCRIPTION]   - Final design tin 

11. tin/Design/Area ID/[DESCRIPTION]  - Final design tin with area/zones 

12. tin/Apply/Trimesh/*[PAVE TYPE]  - Pavement tins see Pavement Manager 

 

Supertins have a prefix tin/Super/Design. 

• tin/Super/Design/[DESCRIPTION] - Combinations of Design tins 

• tin/Super/Design/Area ID/[DESCRIPTION] - Combination of Design tins in a 
area/zone 

• tin/Super/COMBINE   - Combination of Design and Survey tins 
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6.0 DESIGN FUNCTIONS 

Most of the working design models are created from Apply MTF functions.  There are other 
functions that create the model names.  These are to follow standard naming conventions. 

 

6.1 Function naming 

General Functions 

Prefixes for general function naming: 

• Contour/Proposed/* Proposed Contours 

• Contour/Existing/* Existing Contours 

• Component/*  Component design object function 

• Pave/*   Pavement by Tin colour 

• Widening/*  Widening function (Creates Tin envelops) 

• Inter/*   Interface function 

• Table/[Type]/*  Setout table for Super Alignments 

• Ramps/*   Pedestrian ramp function 

 

Apply MTF 

Design Apply MTF function naming: 

• Apply/aHwy/*  Highway design strings function 

• Apply/aMwy/*  Motorway design strings function 

• Apply/aRoads/*  General Road design strings function 

• Apply/bKerbs/*  Kerb Return design strings function 

• Apply/cTraffic/*  Traffic Island design strings function 

• Apply/dDrain/*  Drainage channel strings function 

• Apply/Pave/*  Separate apply function pavement snippets 

• Apply/Xfall/*  Crossfall strings function 

 

 

Default settings for the Apply MTF function can be altered under, Design => Apply => 
Defaults => Apply MTF Defaults.  The shipped version has been set as a base default to 
comply with the Public Works naming standards.  However, if modifications are required. the 
new apply_many_defaults.4d file should be kept in the Company User folder for 
consistency settings for all Users. 

 

 

• The optional component is for list order 

• “*“ represents alignment name. 
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The Apply MTF function, Design => Apply => Apply MTF 

 

 

 

  

 

 

Initially type the 
name of the 
Alignment.  Then 
select <Enter> 

Note:  This will 
populate the 
required fields in 
the Apply function 

Add final name Select matching MTF file 
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MTF Manager 

If using the Apply MTF Manager to create functions and MTF files, then the above is not 
required.  The Apply MTF Manager still use the Apply MTF Defaults to create its models. 

Design => Apply => Apply MTF Manager 

 

 

TIN Functions 

TIN function naming: 

• tin/Existing/*  Existing / Survey tins 

• tin/Design/*  Proposed tins 

 

 

 

 

 

 

The “*” is for the description.  It could also include an extra grouping to 
represent an area or zone.  E.g. tin/Design/01/ROADS 

 

 

Model 
Selection 

Type function 
prefix 

Alignment names 
from model selection 
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6.2 MTF Naming 

MTFs are created to run in the Apply functions and should follow the same naming as the 
functions with the “/” replaced with a space. These represent the action they are performing 
on an alignment. 

e.g. Function Apply/Roads/RSA01 would contain MTF Apply Roads RSA01 

 

When MTFs are run in the Apply functions they are to run with NO errors. 

 

 

 

 

Note: Additions functions are to be documented in the 

Project Description Panel 
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7.0 DATA IMPORT AND EXPORT 

7.1 Data Import 

Data importing is important to synchronize data across different areas, disciplines and 
external consultants and existing features.   

There are numerous file types that might be received, e.g. general data files, dat or txt 
formats or 3d dwg or dxf files.  These are to be processed and read into 12d Model Projects 
for ease of sharing between all Users on a project.  the Projects using naming rules SUR, 
XDD and XTR are to be used for this purpose. 

All files for importing are to be located under the 04_Data Transfer/Inputs folder. 

 

Using this input folder allows for easy data update in the reference projects via chains. 

See 10.0 Chains 

 

External Data 

Excluding survey data, Data read in from the Import folder from external sources are to go 
into 12d Model projects e.g. [Project No.] XDD 

This data can be received in many types, e.g. 12da, IFC, 2d/3d DWG or DXF files or other 
xyz type files. 

For any data read in, the model names are to be prefixed.  This prefix is Xternal/Type/* 

The optional Type is to group the data. It could also include sub groups e.g. 
Xternal/Utilities/Gas/* 

For 12da data this might just be a simple Prefix to add to the models, otherwise a mapfile file 
can be applied when reading the data in.   

 



 

 

PW Guidelines 

12d Standards and Procedures 

Page 32 

 

If more complex data fixes are required, then using a Map file when importing the data is to 
be used.  Mapfiles can be created under File => Map Files => Create/edit.   

There are several Public Works standard map files shipped with 12d Model to use or be an 
example. 

• PW_DESIGN.mapfile  - Primary for the Apply MTF function.  Maps 
template or snippet template strings to plottable colours and applies line styles, etc. 

• PW_SURVEY.mapfile  - For survey data import to make PW compliant. 

• PW_SURVEY_GREY.mapfile - Same as the PW_SURVEY.mapfile, however 
changes string colours to grey colours. (mainly used for export design plots) 

 

Simple mapfiles can be created if just being used to prefix models.  These can then be saved 
to the company User_Lib or Customer_Lib folders for use on other projects if required. 

 

 

If the import data is already model named appropriate, 
then a simple prefix can be used as shown here. 
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7.2 Sharing 

Sharing Models and Tins into your project from other projects means you can have copies of 
the data that update if changed in the origin projects.  This means the copies are not 
uncontrolled duplicates. 

There are two ways to share in Models and Tins, either through Direct sharing or by using 
Master shares.  In both cases the data must first be shared out from the origin projects. 

 

Sharing Out 

Sharing data out is done via Project => Sharing => Share models out and Project => 
Sharing => Share tins out .  Or, he Sharing Toolbar 

Sharing -> Share Models Out and Sharing -> Share Tins Out  

   

 

 

 

Name the mapfile 

Enter string name 
to change details 

Type the model 
name to change to 

Can change any other 
details if required 

Possible other items 
that can be added or 
modified 

Enter only if the string 
name needs to change 
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In the Share Models Out, there is No need to share out the Tin models.  
Tin models are automatically done when the Tin is Shared in. 

 

 

Select Models and 
or Tins to share out 

Select <Save>  
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Once Models and Tins are shared out the colour display in the model list changes colour 
from black to an orange representation. 

 

 

Direct Shares 

From your own project you can use direct shares to share in other projects models and Tins 
that have been made available.  This method means that you the User chooses which 
Models and Tins you want to share in and requires you to check when other data is made 
available. 

Sharing data out is done via Project => Sharing => Share models In and Project => 
Sharing => Share tins In .  Or, he Sharing Toolbar 

Sharing -> Share Models In and Sharing -> Share Tins In   

   

 

 

Black = Non-Shared out data. 

This could be data that you 
don’t need other projects to 
see or use e.g. Construction 
data 

Orange = available 
for other projects to 
share in 
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Select project 

Select models to 
share in 

<Share in>  

When the Models are shared in, 
they will appear highlighted. 
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Select project 

Select Tins to share 
in 

<Share in>  

When the Tins are shared in, 
they will appear highlighted. 
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When models and Tins are shared in, they display in a blue colour in the model list. 

 

 

 

Master Shares 

A Master Share file is a file that contains Projects Models and Tins, this file can be updated 
to add or remove Models or Tins at any stage.  Unlike direct sharing, if a user subscribes 
their project to a Master Share file, they will get the data that is in it automatically.  Models 
and Tins can be added or removed from a Master share file at any stage and the Projects 
subscribed to it will automatically get updated. 

As noted previously, a Master share file does not make a Model or Tin available, this is done 
via sharing out first.  Once this is done the Models and Tins can be added to a Master Share 
file. 

Master Share files are created and subscribed to through the Share Manger in 12d Model 
V15. 

 

Project => Sharing => Share manager, or toolbar 

Sharing -> Share Management   
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To create a Master Share file, go to the Share Out tab. 

 

 

 

  

 

 

 

Select to add new 
Master Share file 

Browse to 05_MShares folder 
and name file.  

Select to add project. Generally, the current project. 

Note, whilst multiple projects can be added to a 
Master Share file, recommend just the one for easy 
management. 

Browse to the project 

Then select the 
Models and Tin/s to 
add to the Master 
Share file 

<Save>  
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To subscribe to a Master Share file, go to the Share In tab. 

 

 

 

 

 

 

 

The Models and Tins shared in from a Master share file are still displayed 
in the blue colour as per direct sharing in. 

 

 

Select add new Master Share 

Browse to the 05_MShares 
folder and select file 

<Save> Synchronises Models and Tins in 
from the Master Share projects 

Project/s in the Master Share file.  Expand to 
see what Models and Tins are included 

<Synchronise> Checks for updates to Models and Tins 

<Convert to direct shares> As described 

<DeShare> Binds Models and Tins into the project 

<Remove> Removes subscription to Master Share file 
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7.3 Data Export 

Exported data from the 12d Model projects is to be saved to the 04_Data Transfer/Export 
folder and then under the appropriate category sub folders.  These locations are NOT a 
reference location for the Project but a checking location for the 12d Users.  When the User 
is ready, they can copy these files to there required reference folders on the network or 
Common Data Environment.  This controls when the data is ready to be referenced (The 
data may also be required to pass through the ISO 19650 checks prior to being in a sharing 
state). 

 

 

All data exports are to be recorded in a Chain to automate the export and control/record the 
data that is being exported.  See 10.0 Chains.  For this reason, no dates should be included 
in file names. 

While file naming rules may vary depending on the project, the base PW standard is as 
follows: 

[Project Number]-[Export Type]-[Area No.]-[Description] 

 

Export Type Codes: 

 

DA - Design Alignments 

DP - Design Plans 

DC - Design Cross Sections 

DL - Design Long Sections 

SP - Survey Plans 

XP - External data plans 

 

Examples: 

  12345678-DP-A-CONTOURS-2D.12da 

12345678-DP-DESIGN.12da 

  DA-01-ROADS.12da 

 

 

Category sub folders. 
Add as required 
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12d Data 

A 12da or 12daz (compressed) files are defined and published by 12d Solutions to allow data 
to be easily transferred from other programmes to 12d Model.  A 12da file can contain all the 
entities from a strings name, colour, line style and symbol, including coordinates, models 
name, attributes, Trimeshes and Tins, etc. 

Found under the File => Output 12d or File => Date output => 12d => 12d archive data 

 

 

BIM Data 

The Standard format for BIM exports is IFC. 

 

 

 

ADAC 

For ADAC production see the PW Guidelines – Asset Capture 

 

 

Select output type 

Select Data source and 
data 

Browse and type file name 
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Cad data 

For offices exporting the 12d data for CAD Xrefs here is a guide.  If producing the final PDF 
via 12d Model through MPS (Multipage Plots) then refer to 9.4 MPS (Multipage Plots). 

For DWG exports for Xref purposes the same naming rules are to apply however a “X-“ prefix 
is to be added. 

Examples: 

X-12345678-DP-DESIGN.dwg 

X-DL-RSA01.dwg 

Provided the Public Works naming convention is used for 12d Model strings, Standard export 
files are shipped to map 12d strings to CAD layers.  This is done via an acadmf file which 
matches layers already set in a dwt file. 

For the line types from 12d Model to match CAD, first download the CAD line style shape 
files from the 12d Model forum site: 

https://forums.12dmodel.com/download/file.php?id=1122 

This is a zip file PW_CAD_Files.zip.  This file contained: 

- Shapes folder 

- PW_Linetypes.lin 

- PW-A1.ctb 

- PW-A3.ctb 

- CAD pen widths.jpg 

The CTB files included, are for A1 and A3 plotting. 

Set the Line style and CTB files to the required CAD support paths. 

The included image is a visual guide to the standard black pens and widths set to match 12d. 

  

 

 

 

 

 

 

12d Colour number 
and display number 

CAD colour 

RGB colour 

Display colour 

Pen thickness 

https://forums.12dmodel.com/download/file.php?id=1122
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For DWG export, File => Data Output => DWG/DXF/DXB => DWG/DXF/DXB 

Or Toolbar, Quick Access -> Data Export -> DWG/DXF Export  

 

 
 

Select data 

Settings 

Select PW template file 
– see Library files 

Select PW acad mapfile 
– see library files 

Browse to Export/CAD 
folder and type name 

Select type 
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PW Library [Lib] files for exporting 12d strings to CAD. 

Dwt files included: 

 PW_DESIGN_export.dwt - Design strings output 

 PW_SURVEY_export.dwt - Survey strings output 

Each dwt file has a matching acadmf file: 

 PW_DESIGN_export.acadmf - Design 12d String to CAD layers 

 PW_SURVEY_export.acadmf - Survey 12d strings to CAD layers 

 

 

 

  

 

                                   

 

Note:  Survey CAD exports to default colours.  If exporting survey for 
design Xref use, the user will have to change the CAD layer colours to 
desired grey colours for existing features.  Suggest matching colours to 
PW_SURVEY_GREY.mapfile 

 

 

De-select 
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Design dwt 

 

 

  

 

 

dwt legend inserted 
at 0,0 

Detail 
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Survey dwt 

 

 

 

dwt legend inserted 
at 0,0 

Detail 
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8.0 STANDARD COLOURS AND PEN WIDTHS 

The colours.4d file shipped with 12d Model comes with the standard display, plotting, 
Visualisation and SUI colours required for projects. It also contains 100s more colours. 

 

How many colours that are displayed when you select a colour box is controlled through the 
Project Settings under, System => Display colours (default = 116) 

 

 

 

 

 

Pop-up No. controls 
order of display 

How many displayed 

Colour name 

Grouping 

RGB colour creation 

Colour 
number 

Description of colour.  PW colours 
include plotting width 
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8.1 12d Colours 

Standard 12d Model colours used visually but have been assigned pen widths so that they 
can be used in general. 

 

Refer to the plot map files for pen widths and colours. 

 

8.2 Plotting Colours 

Specific colours set for known plotting widths.  These include black pen widths to match CAD 
outputs. 
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The above colours are set to match the ACAD CTB file so 12d Model plots match CAD plots. 

 

There are also colours used for plotting from the PPF files. See Plotting section. 

The below are the Colours assigned to the PPF files. 
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8.3 SUI Colours 

Surface Utility colours are the Australian Standard AS5488 colours for utility types. 

The primary colours for SUI AS5488 are: 

 

Due to plot ability, the Public Works has modified some these colours to display as the 
following: 

 

Communications (White)  

Drainage (Green)  

Electricity (Orange)  

Fire Service (Red)  

Gas (Yellow)  

Petroleum (Brown)  

Recycled Water (Purple)  

Sewer (Cream)  

Unidentified Services (Pink)  

Water (blue)  

 

Utility SUI Colour PW Colour 

Communications (White)   

Drainage (Green)   

Electricity (Orange)   

Fire Service (Red)   

Gas (Yellow)   

Petroleum (Brown)   

Recycled Water (Purple)   

Sewer (Cream)   

Unidentified Services (Pink)   

Water (blue)   
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8.4 Visualisation Colours 

Visualisation colours are used initially in Templates or Snippet Templates to set polygon 
colours for colouring of Tins.  If you have the Visualisation module in 12d Model these 
colours can be used with the shipped texture_map.4d file to associate the colours to 
textures for Visualisation like 3d drive throughs. 
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9.0 PLOTTING 

12d Model ships with the Public Works standard plot files for the mapping of pen widths and 
colours, and the Plot Parameter Files (PPF) for printing PDF files for Plans, Long and Cross 
Sections. 

There are also standard files included for exporting CAD dwg files. 

 

9.1 Plot Map Files 

The Public Works Standards includes two full size pen Plotter Map Files (pmf) and two half 
size pen widths pmf’s.  One of each for in black pen only and one of each for plotting in 
colour. 

• PW_full_scale_12d_black.pmf 

• PW_full_scale_12d_colour.pmf 

• PW_half_scale_12d_black.pmf 

• PW_half_scale_12d_colour.pmf 

To see the setups for these read them in using Plot => Plotting Setups => Plotter mapping 
editor . 

On the Default tab indicates the default pen width if not assigned. 
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Pen mapping tab, indicates pen number and weight assigned: 

 

Pen colours tab, indicates the colour it will plot.  Set as RGB: 
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9.2 Title Block File 

The Public Works also has standard title blocks that ships with 12d Model. They can be 
found in the Library: 

• 12d_PW_A1_title_block.tbf 

• 12d_PW_A3_title_block.tbf 

To See, Plot => Plotting Setups => Read title block file 

 

This title block can be used as is.  If changes are made it can be saved as your company 
standard, Plot => Plotting Setups => Create/edit title block file 

 

The TBF files include text for the items listed in the above picture.  This text can be filled out 
manually in the PPF or via a spreadsheet register, see Plot Parameter Files. 

To use the text in a PPF it must include certain criteria: 

<$Option,Title Reference> 

1. The TBF Text must be surrounded in<> 

2. Option Text 

• $user_text – User defined text 

• $project_detail_(Project Detail name) – Fill in via the Project Details. 

 

Revision history 

Location, Project 
and file information 

Note area Logo area 

Sign off area Title area 

Drawing information 
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• $12d_synergy_Job_(Attribute name) – Getting information from 12d 
Synergy Job attributes. 

 

 

9.3 Plot Parameter Files 

The Public Works Standards includes base Plot Parameter Files (PPF) for plotting Plans, 
Long and Cross Sections.  These PPFs can be used as is or modified to suit individual 
company requirements.  If changes are required, save the new base PPFs to the companies 
User Library or Customer Library folders. 

 

Plan PPF 

The standard Plan PPFs found in the Library: 

• plot_frames_PW_A1.plotframeppf 

• plot_frames_PW_A3.plotframeppf 

 

Prior to creating plan plots, Setup a Plot view, e.g. PLOT : 

• add the models required  

• Set the view rotation 

• Apply mapfile/s to set pens/colours (If required) 

• Save a view favourite – PLOT PLAN [Discipline] [Sheet No.] – (using Single frame) 

 

Read in the above standard plan PPFs: 
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Model of frames: 

 

 

The primary output is PDF.  Model is used for checking or prior to outputting to DWG for 
sketches, see CAD exports.  Plot file stem: 

• PDF – See Export naming convention 

• Model - Plot/[Export Type]/[Description] 

 

 

When setup save to 
project as type – 
[Discipline] A1 

Select model of frames. 
Created from 
Plot=>Plans=>Plot 
frames=>Create  

Plot to Model or PDF 
PDF options below 

Plot file name. 

Example plot frame Create 
 
Model Name: Plot/Frame/[SIZE] [SCALE]  

 

Pick location 
information 



 

 

PW Guidelines 

12d Standards and Procedures 

Page 59 

 

 

 

  

 

 

Plot to models used if 
plotting to models 

PDF output options 
100% - for A1 
50% - for A3 
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Using a Title Block: 

 

 

 

 

 

 

 

Select  

Can be used with a 
drawing register for title 
block information 
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Long Sections (PPF) 

There is substantial setting up to create long section PPFs.  The Public Works standards 
have included numerous options to minimise time in producing the outputs required. 

The standard Long Section PPFs found in the Library: 

• longsection_PW_A1_basic.lplotppf 

• longsection_PW_A1_basic_SE.lplotppf 

• longsection_PW_A1_services.lplotppf 

• longsection_PW_A1_services_SE.lplotppf 

• longsection_PW_A3_basic.lplotppf 

• longsection_PW_A3_basic_SE.lplotppf 

• longsection_PW_A3_services.lplotppf 

• longsection_PW_A3_services_SE.lplotppf 

As noted, there is two plot sheet sizes for A1 and A3. 

The different types represented are: (See notes section in PPFs) 

• basics   - Minimal labelling via the Cuts branch. 

• basics_SE - As per the services option, includes Super elevation diagram box. 

• services - For detailed labelling via the Cuts branch.  It provides a dedicated 
area for labelling cuts with staggered uprights.  Used with a chain to for pre-
processing of cut strings, e.g. services. 

• services_SE - As per the services option, also includes Super elevation diagram 
box.  

 
 

Look in Notes for 
important 
information on how 
the PPF works 
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Any base changes made to the standard library long section PPFs should be saved to your 
company User Library for future base reference. 

Naming: 

LS-[Company name]-[Sheet Size]-[Type].lplotppf 

 

For project specific change, the PPF should be saved to the working project. 

Naming: 

LS-[Sheet Size]-[Alignment name]-[Type].lplotppf 

 

 

Cross Sections (PPF) 

There is substantial setting up to create Cross section PPFs.  The Public Works standards 
have included numerous options to minimise time in producing the outputs required. 

The standard Long Section PPFs found in the Library: 

• xsection_PW_A1_basic.lplotppf 

• xsection_PW_A1_services.lplotppf 

• xsection_PW_A3_basic.lplotppf 

• xsection_PW_A3_services.lplotppf 

As noted, there is two plot sheet sizes for A1 and A3. 

The different types represented are: (See notes section in PPFs) 

• basics   - Minimal labelling via the Cuts branch. 

• services - For detailed labelling via the Cuts branch.  It provides a dedicated 
area for labelling cuts with staggered uprights.  Used with a chain to for pre-
processing of cut strings, e.g. services. 
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Any base changes made to the standard library Cross section PPFs should be saved to your 
company User Library for future base reference. 

Naming: 

XS-[Company name]-[Sheet Size]-[Type].lplotppf 

 

For project specific change, the PPF should be saved to the working project. 

Naming: 

XS-[Sheet Size]-[Alignment name]-[Type].lplotppf 

 

 

  

 

Look in Notes for 
important 
information on how 
the PPF works 
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Drawing Register 

An option for filling out title blocks more automatically for multiple sheets is to use a drawing 
register.  This is done using a CSV file, although this CSV file can be created using an excel 
or macro enabled excel file.  These files link to filling out title block information via the Text in 
the Title Block File (TBF).   

The 12d Model Library contains an examples: 

• drawing_register.xlsm 

• drawing_register.xls 

• drawing_register.csv 

The drawing register file should be copied from the 12d Model Library to the working folder 
or, if project specific, the User Library or Customer User Library of your project so that is not 
in a read only location. 

 

Excel (Macro enabled) register example:  

 

The Save as CSV button is a macro. 

Excel formulae can be used to create values in all formats of the excels files, e.g. a 
Concatenate function, the combining to two or more cells into one cell. Can be used for total 
sheets etc. 

 

  

 

Values form file 
name 

Creates the CSV 

For MPS use. 
Chapter names 

How it works Tab 

Drawing no value made 
up by combinations of 
other values 

Column information either 
from typed values or 
combinations of other sources 
e.g. Project Details, etc.  
See How it works Tab. 
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CSV/XLS register example: 

 

 

 

9.4 MPS (Multipage Plots) 

MPS is a way to directly output 12d data to final PDFs.  The outputs include multiple types, 
e.g. plans, sections and 3d PDF.  The Public Works standards ship with an A1 and A3 
example in the Library [Lib]. 

• Plot_PW_examples_A1.12dmpsf 

• Plot_PW_examples_A3.12dmpsf 

Any base changes made to the standard library MPS files should be saved to your company 
User Library for future base reference. 

Naming: 

Plot-[Company name]-[Sheet Size]-[Type].12dmpsf 

 

For project specific change, the PPF should be saved to the working project. 

Naming: 

Plot-[Sheet Size]-[Type].12dmpsf 

 

  

 

Note:  Similar to the xlsm, although no save 
CSV button.  Title row must be at the top. 
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Example MPS: 

 

 

  

 

Book Node 

Chapter Subnode 

Page Subnode 

Insert Title block, 
Frame, Text, 
Symbol, Model and 
special Chapter 
Subnodes 

Subnodes apply to 
the level and any 
sub-level below. 

Notes about the MPS 
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The Public Works MPS example uses a drawing register to populate the title block 
information, see Drawing register. 

 

Title Block Information. 

 

 

 

 

 

 

 

General Title 
Block details 

Shipped PW title block 
file. Optional to change 
to Company version if 
modified 

Reference information 
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Drawing register. 

 

 

 

Default is shipped Public Works 
example. Copy and change to 
project location. 

Select Type 
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10.0 CHAINS 

Chains are a documented ordered process of user defined commands in producing a design 
or required exports.  Any repetitive tasks should be Chained. 

The default location for a saved Chain is the Working folder of the 12d Model Project.  
However, Chains for common tasks or a base standard of Chain can be kept in a User Lib or 
Customer Lib.   

 

10.1 Design Chains 

 

All Design work is to be Chained. 

 

There are two types of Chains, Master Chains and Component Chains. 

Master Chains are used to group the Component to complete a task, e.g. Design. 

 Naming: 

• 000 DESIGN  Runs all design Chains to Recalc the entire project 

• 100 PLOT  Plotting master Chain 

• 200 EXPORT  Write all files for external issuing 

• 300 REPORT  Creates all reports, e.g. Volume, sight distance. 

 

Component Chains are sub parts, or specific areas of a project that can be run for targeted 
updates when the entire project doesn’t require the update. 

 Example Design Chain naming: 

• 010 DES Mainline  Main carriageway on highway or motorway 

• 010 DES Area 1   Area 1 design 

• 020 DES Interchange A  Interchange design 

• 020 DES Area 2   Area 2 design 

Note:  Component design chains may not be required if design projects are small. 

 

Example Plot Chain naming: 

• 110 Plot Plans   Write all plan plots to dwg or MPS execute 

• 120 Plot LS   Plots all Long Sections 

• 130 Plot XS   Plots all Cross Sections 

 

Example Export and Report naming Chains: 

• 210 12da   Writes 12da file exports for the project 

• 220 IFC    Writes IFC file exports for the project 
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• 230 ADAC   Write ADAC exports 

• 310 Volumes   Writes Volumes reports for design 

• 320 Sight   Writes Sight distance check reports 

Design Chains are not limited to the above and further Master Chains can be added with 
their optional Component Chains if required.   

The third number can also be used if further sub Component Chains are required for a 
process. 

 

  
                                            

Master Chains 

Component Chains 

Component Chains 

Component Chains 
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10.2 Survey Chains 

Survey Data, whether received from an internal or external source is to be controlled via a 
Chain also.  Benefits include: 

• Identifies the data source via paths and comments 

• Updates are easily processed 

• Applied Map files can control consistency across string and model naming 

• Survey TIN surface is updated with the data and optionally copied and translated to 
create a striped surface. 

When power of the Chain update is combined with Model sharing, survey data revisions are 
easy to control. 

 

 

 

 

Note:  The design chains are your ordered process of how the Design works.  
Make sure it is documented as if you might be taking over the Design. 

 

Use Chain Regions to group 
activities together 

The comment box can be 
used for extra notes 

Use Chain Comments 
within Regions to break up 
the activities 
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Example Survey Chains: 

 

As per the Design Chains, the Master Chains run the Component Chains.  The Master 
Chain in this case can also just contain the survey data import and main existing surface 
triangulation.  This could also be done in a Component Chain, e.g. 010 Survey. 

 

In this example the optional Component Chains do: 

• 010 Cadastral - Can import cadastral boundaries if required and drape them onto 
the existing surface for use in cross sections. 

• 020 Pavement - Identifies the existing pavement surface and creates a triangulation 
of that area.  Can be used for display information in plans and cross sections. 

• 030 Structures - Creates triangulated surfaces of the top and soffit of the existing 
bridges. Can be used for display and also clearance checks. 

• 110 Plans - Export of 2d and 3d survey data to required files 

• 120 Contours - Update and export require contour files in 2d and 3d. 

 

 

                                        

Master Chains Component Chains 

Component Chains 
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11.0  EXAMPLE PLOTS 

 

11.1 Design Plots 

 

 

 

 

11.2 Survey Plots 
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NOTES:  
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